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End User License Agreement 
This is a legal agreement between you, the end user, and Gaumard® Scientific Company, Inc. 
(“Gaumard”). This software is protected by copyright laws and remains the sole property of 
Gaumard. By installing the GIGA (the "Software") media, you agree to be bound by the terms of 
this agreement. If you do not agree to the terms of this agreement, promptly return the uninstalled 
media and accompanying items to Gaumard at the address indicated below. 

1. Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install 
and activate the Software on one computer for use with one Interactive patient simulator system. 
The software may also be installed on any number of other computers at the same institution so 
that students may access the learning resources. One copy of the software may be made for 
backup purposes. You may not network this Software, or allow multiple users unless you 
purchased a multi-user workstation license. Sharing this Software with other individuals or allowing 
other individuals to view the contents of this Software is in violation of this license. 

2. Copyright. The Software is owned by Gaumard and protected by United States copyright laws 
and international treaty provisions. Therefore, you must treat this Software like any other 
copyrighted material. You may not make this Software or copies thereof available in any manner or 
form or use, copy or transfer the Software, in whole or in part, except as provided herein. 

3. Other Restrictions. You may not rent or lease this Software to any other party. You may not alter, 
merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the 
contents of this Software to any other party. 

4. Electronic Transmission of Software. If you received the Software by electronic transmission or 
by Internet delivery, by installation of the Software, you acknowledge that you have read and 
understand this license agreement and agree to be bound by its terms and conditions. 

5. Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto 
shall commence upon installation of this Software. This Agreement and the license granted herein 
may otherwise be terminated by Gaumard in the event that you are in breach of any provision of 
this Agreement. In the event of termination, you agree to immediately return this Software, 
accompanying items, and any copies thereof to Gaumard. 

6. LIMITED WARRANTY 

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS 
WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE 
FROM DEFECTS IN MATERIAL AND WORKMANSHIP. ELECTRONIC TRANSMISSION IS 
WARRANTED TO BE FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR 
SOLE AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE 
DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC TRANSMISSION PROVIDED THAT 
YOU NOTIFY GAUMARD IN WRITING OF SUCH DEFECT OR DEFECTIVE TRANSMISSION 
AND RETURN THE DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD. 

(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE 
SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS" 
BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR 
PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS 
DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN 
ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY 
SUCH INFORMATION OR ADVICE. GAUMARD DOES NOT WARRANT, GUARANTEE, OR 
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF THE 
SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 
RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE RISK AS TO THE 
RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE 
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS 
DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY 
DESCRIBED ABOVE. 
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(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, 
INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS 
OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR 
RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS 
ARISING OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE 
AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE 
UNDER, IF ANY, EXCEED THE PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE. 

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED 
BY GAUMARD. 

ACKNOWLEDGMENT 

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND 
UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL 
PROPOSED OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED 
HEREIN. 
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General Care, 
Maintenance, and 
Warnings 
The Gaumard warranty does not cover 
damage caused by misuse. It is critical to 
understand and comply with the following 
guidelines to prevent injury to the user and 
damage to the simulator. 

PROCEDURES 

Do not attempt to intubate without lubricating 
the airway adjunct with silicone lubricant 
(provided). Intubating the simulator without 
lubrication may result in damage to the 
airway. 

Avoid using surgical tools to cut the neck 
skin. The precut opening allows the insertion 
of most medical devices. Always lubricate 
the medical adjunct before insertion. 

Do not introduce flammable gases into the 
airway. 

Providers must use an empty syringe when 
simulating drug administration via 
endotracheal tube. Passing liquids into the 
trachea or esophagus may cause internal 
damage. 

Mouth to mouth resuscitation without a 
barrier device is not recommended, as it will 
contaminate the airway. Treat the simulator 
with the same precautions that would be 
used with a real patient. 

IV ARM 

Vein tubes contain latex, which may 
cause allergic reactions. Users allergic or 
sensitive to latex should avoid contact. 
Discontinue use of this product and seek 
medical attention if an allergic reaction 
occurs. 

Use only simulated blood provided by 
Gaumard. Any other simulated blood brand 
containing sugar or any additive may cause 
blockage and/or interruption of the 
vasculature system. 

The use of needles larger than 22 gauge will 
reduce the lifetime of the lower arms' skin 
and veins. 

When the arm veins require replacement, 
contact Gaumard to arrange for a lower arm 
exchange. For a small fee, we will deliver 
reconditioned and warrantied lower arm 
assemblies to your facility. Upon receiving 
the replacement arms, use the same box 
and the enclosed shipping label to return the 
old arms to Gaumard. For international and 
express service, additional fees may be 
charged. Refer to the Consumables and 
Replacement Parts section of this guide, and 
contact customer service for more 
information. 

STORAGE 

Store the simulator in a cool, dry place; 
extended storage above 85 degrees 
Fahrenheit (29 Celsius) will cause the 
simulator to soften and slowly warp. It is 
acceptable to operate NOELLE at an 
ambient temperature of 95 degrees 
Fahrenheit (35 Celsius). 

Do not store the simulator with a discharged 
battery. Re-charge the backup battery at the 
end of every simulation session. In addition, 
recharge the battery at least once every 30 
days even if the simulator is not in use; 
otherwise, permanent loss of capacity might 
occur because of self-discharge.  

Do not allow any objects to rest on the face 
or chest skin or store the simulator face 
down. Pressure points on the face and chest 
skin may warp or damage the skin. 

CLEANING 

Clean the simulator with a cloth dampened 
with diluted liquid dishwashing soap. If 
medical adhesives remain on the skin, clean 
with alcohol wipes.  

Do not use citric acid cleaners anywhere on 
the simulator. Doing so will cause pitting of 
the various materials comprising your 
simulator. 

The simulator is "splash-proof" but not 
waterproof. Do not submerge or allow water 
to enter the interior of the simulator. Do not 
expose the tablet computer to water or 
excessive dust. 

Always purge and drain the internal fluid 
reservoirs and vein reservoirs at the end of 
the simulation session. Doing so will prevent 
molding or clogging. 
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Defibrillation / 
ECG 
ELECTRICAL THERAPY 

Defibrillation is allowed only on the large 
sternum and apex sites. Do not deliver a 
shock to ECG electrode sites on the 
shoulders or waist . 

For exercises that incorporate real electrical 
therapy of any kind, always follow the safety 
guidelines and operating procedures outlined 
in the medical device’s directions for use 
documentation. 

Only deliver electrical therapy when the 
simulator is fully assembled, dry, and 
undamaged. 

Make sure the defibrillation patches on the 
simulator are in good condition, including 
removing all gel residue on the defibrillation 
patches from previous use(s).  

It is a good practice to remove gel residues 
after every use. Failure to do so will leave 
behind a film of electrode gel that hardens 
causing arcing and pitting. 

Do not re-use the gel-adhesive pads. Do not 
leave them on for next day use. 

Use hard paddles or wet-gel pads preferably. 
Avoid using solid-gel pads since they 
present higher risk of burning the simulator’s 
skin. Gel pads have a shelf life. Make sure 
they are not expired to avoid arcing. 

Make sure the simulator is not in contact with 
any electrically conductive surfaces. 

Use the simulator only in a well-ventilated 
area, free of all flammable gases. 

NEVER attempt to service or modify any of 
the electrical connections, especially those 
between conductive skin sites and the 
internal electronics.  

Discontinue use if any wires are found 
exposed with damaged insulation. 

Real medical products, especially 
electrodes, sometimes use powerful 
adhesives that can be difficult to remove. A 
gentle, degreasing cleanser may be needed. 

Electrode gel on the skin between any two 
electrode targets can become a pathway for 
electrical current, just as in real life. If this 
occurs, the simulator’s skin can be burned. 

Do not allow defibrillation pads to overlap 
ECG sites. Doing so will may damage the 
simulator and cause arcing. 

Should dark traces appear on the conductive 
patches due to gel residue or previous 
arcing, use a pencil eraser to remove the 
traces and then clean with alcohol.  

DO NOT SCRATCH the conductive patches 
with abrasive objects; doing so will cause 
irreversible damage to the conductive sites 
and subsequently cause arcing. 
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Terminology 
Facilitator - the person conducting the 
simulation; an instructor or lab staff member. 

GUI - the Gaumard User Interface - is the 
software application, used to control the 
simulator and evaluate care providers. 

Palette - a collection of Palette Items. Each 
profile has its own palette. 

Palette Item - Any full or partial set of 
physiological parameters that have been 
grouped and saved together under a single 
name. 

Profile - a unique NOELLE software 
configuration, including custom Palette, 
Scenarios, and options. Each Profile acts as 
a separate program, in that changes made to 
one profile have no effect on the others. 

Provider - a person participating in the 
simulation as a healthcare provider. 

Scenario - a saved sequence of 
physiological states, like a "playlist." 
Scenarios provide a level of automation that 
unburdens the facilitator and allows 
standardized presentation of symptoms. 

Scenario Item - a Palette Item that is part of 
a scenario. Scenario Items may also 
represent a fixed delay period ("Wait") or a 
pause ("Wait Indefinitely"). 

Stylus - a special pointing device for the 
tablet computer. The stylus is the fastest and 
easiest means of controlling the NOELLE 
software. See the Equipment Set-up section 
of this guide for more information on working 
with the stylus. 
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Getting Started 
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Simulator Setup  

SIMULATOR PLACEMENT 

Prepare the simulation area prior to 
unboxing the simulator. The simulator’s 
designated area should have ample space 
for multiple participants to move about freely.  

Remove the simulator from the blue case 
with the assistance of at least two persons. 
Avoid lifting the simulator by the arms as it 
could damage the shoulder joints.  

Rest the simulator on a patient bed capable 
of supporting the weight of a real patient. It is 
recommended that HAL’s head rest flat on 
the bed or on a thin pillow to prevent the face 
skin from shifting.  

BATTERY (HAL 1 YEAR) 

HAL 1 Year includes two separate power 
adapters labeled “Pediatric 1 Year Charger” 
and “Pediatric 1 Year Power Supply”. 

Please review the use for each adapter 
before using the simulator for the first time. 

Pediatric HAL 1 year has a maximum battery 
runtime of approximately 3 hrs. The battery 
charge is displayed on the software panel 
after the connection with the simulator is 
established. Total runtime is dependent on 
the breathing rate, volumes, seizures, and 
muscle tone. 

Feature Runtime 

Internal Battery 3 hours 

WARNING: Do not store the simulator 
with a discharged battery. Recharge the 
battery at the end of every simulation 
session. If the simulator will not be used 
for an extended period, re-charge the 
battery at least once every 30 days. 
Doing so will prevent damaging the 
battery due to discharging. 

CHARGING THE BATTERY (HAL 1 
YEAR) 

The Pediatric HAL 1 Year battery can only 
be recharged using the “Pediatric HAL 1 
year Charger” while the simulator is off or in 
standby. Neither the battery charger nor the 
power supply adapter recharge the battery 
while the simulator is in use. 

Turn the simulator off and connect the 
battery charger to recharge the 
battery. 

To charge the battery: 

1. Close the GIGA software to turn the 
simulator off 

2. Connect the adapter labeled “Pediatric 1 
Year HAL Charger” to the battery port 
located on the simulator’s right side. 

3. Allow the simulator to charge for 2-3 
hours (or until the charger displays a 
green light). The charger indicator light 
will show red during the charge period 
and green once the process is 
complete.  

4. After the charger indicator light turns 
green, disconnect the charger. The 
simulator is ready for use. 

Avoid using the simulator while the 
battery charger is connected. Please 
reference the troubleshooting guide 
for information on how to resolve 
battery issues. 

USING THE POWER SUPPLY (HAL 
1 YEAR) 

The “power supply” adapter allows the 
simulator to operate through long simulations 
sessions by drawing power from the wall 
outlet and not battery reserve. Use the 
power supply for simulation sessions lasting 
2 hours or more. If simulation sessions are 
shorter than 2 hours, using the simulator’s 
battery reserve is recommended.  

The “power supply” adapter will not re-
charge the battery. Avoid using the 
“power supply” adapter if the simulator’s 
battery is completely depleted.  

To operate the simulator from wall power 
using the power adapter:  

1. Fully recharge the simulator’s battery 
using the “Battery Charger” adapter.  

2. Disconnect the “Charger” and connect 
the “Power Supply” adapter.  

3. Activate the GIGA software. The GIGA 
battery icon will display a lightning icon 
while the power supply is connected.  



Pediatric HAL S3005 | User Guide | 13 

Please contact Gaumard for 
information on the power supply 
upgrade for earlier Pediatric HAL 
models. 

BATTERY (HAL 5 YEAR) 

HAL 5 year is equipped with an internal 
battery that allows the simulator to operate 
while untethered.  

Feature Runtime 

Internal Battery 3 hours 

CHARGING THE BATTERY (HAL 5 
YEAR) 

To charge the battery, connect the “HAL 5 
year charger” adapter to the battery port 
located on the simulator’s right side. The 
“HAL 5 year charger” can recharge the 
battery while the simulator is operating. 

Battery charge time is approximately 2 
hours. The AC adapter’s status indicator light 
displays red when the battery is charging 
and green when the process is complete. To 
display the battery level, the GIGA software 
must first establish a connection with the 
HAL.  

WARNING: Do not store the simulator 
with a discharged battery. Recharge the 
battery at the end of every simulation 
session. If the simulator will not be used 
for an extended period, re-charge the 
battery at least once every 30 days. 
Doing so will prevent damaging the 
battery due to discharging. 
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Control Tablet PC 
The tablet PC is preloaded with the GIGA 
control software used by the facilitator to 
initialize the simulator and control the vital 
signs. 

Before turning on the computer for the 
first time, please review the 
documentation included with the 
product for important care and 
warning information. 

USING THE STYLUS 

The tablet’s stylus is a pen-shaped input 
used to interact with files and programs.  

 Left click - tap the screen with the 
pointer. Tap twice rapidly to double-
click. 

 Right click - tap and hold a highlighted 
item or hold the button near the pointer 
and tap the item or text. 

CALIBRATING THE STYLUS 

As part of the initial setup process, calibrate 
the stylus using the Tablet and Pen 
calibration tool in the Windows

®
 control 

panel. Complete the calibration process 
while holding the pen in a natural writing 
position for greater accuracy during normal 
use. 

WIRELESS COMMUNICATION 
USB MODULE 

The controlling computer transmits the 
startup and control commands to simulator 
through the USB RF communication module. 

Connect the RF communication module to 
an available USB port on the tablet. 

 

Secure the RF communication module to the 
tablet or PRO+ computer using the Velcro 
patch. The tablet is now ready to 
communicate with the simulator wirelessly. 
For information about the signal strength 
indicator, go to page 19. 

STREAMING AUDIO HEADSET 

The computer system includes a headset 
that allows the facilitator to speak as HAL’s 
voice and listen to the participants reply. 

Connect the headset MIC and Speaker 
connectors to the designated ports on the 
side of the tablet PC. Go to page 63 for more 
information about the streaming voice 
feature. 

 

Always connect the streaming audio 
headset before starting the GIGA 
software. 
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Virtual Monitor  
The Gaumard Monitors software displays 
HAL’s simulated vital signs in real time. The 
interactive monitoring software is preloaded 
in to the virtual monitors PC.  

The virtual monitor PC also allows the 
facilitator to play back the session recordings 
stored in the PRO+ PC for debriefing. 

 

VIRTUAL MONITOR SETUP 

Refer to the manufacturer’s documentation 
included with the virtual monitor system 
components for important safety, installation, 
and start-up information before turning on 
the PC for the first time. 

To setup the virtual monitor PC: 

 Place the all-in-one PC within line of 1.
sight of the controlling computer 

 Connect the power supply to the PC and 2.
to the wall outlet 

 Connect the USB keyboard and mouse 3.
receiver to the PC 

 Turn on the computer 4.

VIRTUAL MONITOR WIRELESS 
CONNECTIVITY 

The control PC and the all-in-one virtual 
monitor PC establish a wireless link at 
startup automatically. The wireless 
connection allows the Gaumard control 
software to transmit the vital signs 
information to the Gaumard Monitors 
software.  

To verify the wireless link between the two 
computers, click the wireless icon located on 
the task tray. The wireless network name is 
configured at the factory and may differ from 
the one seen below. To troubleshoot 
connection issues between the virtual 
monitor computer and the controlling tablet, 
please go to page 162. 

 

GAUMARD MONITORS 

After the wireless connection is established, 
double click or tap the Gaumard Monitors 
icon to start the vital signs software.  

 

The Gaumard Monitors software is now 
ready to receive the vital signs information 
generated by the GIGA control software. 

 

For more information about the Gaumard 
Monitors software, please refer to the 
Gaumard Monitors user guide. 
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Working with GIGA 
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Initializing the 
Simulator 
After reading the simulator’s direction-for-use 
guide, press the power button to turn on the 
Tablet PC. 

 

The GIGA software initializes the simulator. 
Double click the GIGA icon on the tablet’s 
home screen to open the GIGA software. 

 

The simulator selection menu is shown. 
Select the simulator and click “Start”. 

 

The wireless link between GIGA and the 
simulator is established within 1 minute. 

Profiles and Operating 
Modes 

After the startup screen, the profile and 
operating mode selection menu is displayed.  

 

The GIGA control software has two modes of 
operation: Manual and Automatic. Each 
mode includes a Quick Start profile with 
preprogrammed scenarios exercises created 
in conjunction with experienced healthcare 
instructors and working medical 
professionals. Continue to the next section to 
learn more about the each operating mode 
and the profiles included.  

After selecting an operating mode and 
profile, click “Load” to continue. 

Manual Mode  

In the “Manual” operating mode, the 
facilitator fully controls the vital signs and 
physiologic responses.  
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The Manual mode includes the following 
profiles: 

Default Profile – includes one 

preprogrammed palette with healthy vital 
signs 

Quick Start Profile– includes basic 

preprogrammed scenarios 

Automatic Mode 

The Automatic mode assists the facilitator by 
automatically adjusting vital signs in 
response to caregiver participation, 
pharmacologic intervention, and manual 
input. For example, when facilitator 
increases the heart rate, the Auto mode will 
calculate the response and adjust the blood 
pressure automatically. To activate the 
operating mode as an upgrade option, go to 
page 103. For more information about 
controlling the simulator using the Auto 
Mode, go to page 29. 

 

The Automatic mode includes the following 
built-in profiles: 

Default Modeling – includes one 

preprogrammed palette with healthy vital 
signs 

Meds Profile – includes a library of pre-

programmed medications 

Quick Start Modeling – includes 

preprogrammed scenarios to simulate a 
variety of preprogrammed exercises 

CREATING A NEW PROFILE  

Profiles store palette, scenario, and option 
settings independently; changes made to 
one profile have no effect on the others. 
Below are some examples on how profiles 
are used. 

 Assign one profile to each user of your 
Gaumard simulator system 

 Use profiles to organize and protect 
palettes and scenarios 

 Create a profile dedicated to a specific 
academic course taught by multiple 
instructors 

 Devote an entire profile to one particular 
subject area, or even one particular 
scenario 

To create a new profile, click “New Profile”. 

 

Enter a name for the new profile followed by 
a description. 

 

Enable the PIN protection to prevent 
unauthorized users from accessing or 
making changes to this profile. 

Lastly, click “Create” to save the new profile.  
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GIGA Interface 
The GIGA software is used control the simulator, monitor the vital signs, and evaluate the 
provider’s performance. The simulation technician or instructor carrying out the simulation operates 
the GIGA software. 

The GIGA control elements and scenario programming procedures are consistent throughout the 
Gaumard family of high fidelity simulators. Some software controls and features covered in this 
guide may be hidden depending on the simulator’s hardware configuration and optional upgrades. 

 

Connection Status 

The communication indicator displays the status of the radio link between the tablet’s USB RF 
module and the simulator. Full bars indicate excellent communication (i.e., normal operation). 

 

Battery Indicator 

The battery indicator displays the battery charge information. An exclamation sign is shown when 
there is no communication with the simulator and battery information cannot be retrieved. 

 

The simulator is set to STAND-BY mode automatically when the battery is depleted. The simulator 
will not initialize until the power adapter is reconnected or the battery is recharged. Refer to the 
directions for use guide for charging information specific to the simulator model. 
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Session Clock 

The session timer displays the duration of the current session. Click the timer to reset the clock or 
to start a new session. Event entries in the text log are synchronized with the session timer. 

 

Power/Stand-by 

The power button is located at the bottom right corner of the GIGA software. Toggle the power 
button to set the simulator to stand-by mode and then again to resume. 

 

.
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Status / Details Controls 
The Status/Details panel is used to monitor and control the simulator’s vital signs. The individual 
parameter controls displayed on the details tab provide the simplest method for controlling the 
simulator’s vital signs, sounds, and features. 

There are two viewing modes. The “List view” displays the vital signs controls in a list format, while 
the Body view displays the interactive patient model with floating control boxes. Toggle the view 
buttons to switch between the two modes.  
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SYSTEMS LIST VIEW 

In the List View, the vital signs controls are divided into separate categories. Click through the 
categories to view the controls available for the current simulator configuration. 

 

Enable the “instant apply” option and click the control to change the vital sign to a new value. Vital 
signs undergoing change blink yellow. 
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BODY VIEW 

The “Body View” mode displays an interactive model of the simulator. The model is a 
representation of the simulator and its internal organs. The floating control boxes are used to 
monitor and change the vital signs just like in the “List View” mode. 

 

Use the Body View controls to rotate, zoom, and re-center the model. Click the transparency button 
to view the model’s internal organs. 
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FLOATING CONTROLS 

The floating controls are used to monitor and change the vital signs. The default layout displays 
commonly used vital signs controls. Click the + button to add controls to the floating window. 

 

Enable the “instant apply” option and click the control to change the vital sign to a new value. Vital 
signs undergoing change blink yellow. 
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EXPANDED CONTROLS 

The expanded details view is used to tabulate a list of vital sign changes before applying them all at 
once. In addition, the Details list is used for creating palette items; a set of vital signs parameters 
stored in a single loadable item. Click the edit button to open the expanded Details list. 

 

The vital signs controls are divided into categories. Click through the categories to view the controls 
available for the current simulator configuration.  
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Change vital sign value or state to add it to the Details list. 

 

Click the sound controls tab to change the sound types for audible features (e.g. heart rate) and 
volume level. 
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APPLYING CHANGES 

After the list of changes is created, click “NOW” to update the vital signs instantly. Alternatively, 
click a trending timer to update numerical vital sign parameters (e.g. heart rate, blood pressure) 
gradually.  

 

CREATING PALETTE ITEMS 

A palette item stores one or more vital sign settings into a single loadable object. Use a palette item 
to update a set of vital signs quickly. For example, one palette item can be created to update all the 
cardiac parameters to a healthy state.  

To create a new palette item, set the values for the desired vital signs parameters using the details 
controls and click “Save”. 
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Enter a name for the palette, a description, and choose color code. Click “Save” to create the new 
palette Item. Palette items are stored in the active profile. 

 

When the palette is needed, click the Load button to select the palette from the library. 

 

Select the palette item from the “Load Palette Item” menu and click “Load” 
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Click the apply option to submit the changes. 

 

AUTOMATIC MODE CONTROLS 

While operating in the Automatic Mode, GIGA adjusts the patient’s vital signs automatically in 
response to caregiver participation, instructor input, and pharmacologic intervention. For example, 
if the heart rate is increased, GIGA will calculate a realistic response to the event and adjust the 
blood pressure values automatically. To enable the Automatic Mode as an option in the profiles 
menu, go to page 103. 

Click “Auto Mode” to pause the automatic changes. To return the patient to the initial state, click 
“Reset”. 
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PATIENT PROFILE 

Patient files store general information such as weight, height, and age. The automatic mode factors 
the patient’s weight as it adjusts related physiological parameters. GIGA includes several 
preprogrammed patients in the Quick Start Modeling profile. For more information on the each 
patient profile, go to page 106. 

A default patient is loaded when the Quick Start Modeling Profile is selected and it is an ideal 
candidate for most simulations. Click the patient information bar to view the patient’s profile. 

 

AUTOMATIC MODE CONTROLS 

In the automatic mode, the Details panel includes additional vital sign parameters and control 
options not available in the Manual mode. 
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The “Hold” and “Auto” options are unique to the automatic mode. The “Auto Mode” adjusts vital 
sign controls with an (auto) suffix automatically.  

Checkmark “Hold” to prevent the Auto Mode from adjusting the value. Then change the vital sign to 
the new static value. The automatic mode will not change values set to hold. The “Auto Mode” will 
adjust all other controls set to “auto”. 

 

Some changes are gradual and even if submitted for immediate change. The delay results from 
using a closed loop model that adjusts to the target values over time, rather than displaying a 
unique value that is unrelated to other parameters. 

LUNG CONDITION 

The lung condition parameter adjusts the shunt flow, dead space, airway resistance, and 
respiratory pattern automatically. 
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TIDAL VOLUME 

In the automatic mode, a tidal volume of 450 m/L to 500 m/L is considered the normal level for an 
adult of average build. 

The “auto mode” does not restore the respiratory rate if it is set to zero. Always 
remember to specify a new respiratory rate. 

 

CIRCULATION 

Each cardiac rhythm has a specific effect on the blood pressure waveforms. The pressure 
waveforms include ABP, CVP, PAWP, and Pulse. The blood pressure values are affected when 
any of the following parameters are changed: 

 Vascular profiles: vessel diameter and vessel stiffness 

 Heart Rate 

 LV Contractility 

 Total Blood Volume 
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PATIENT STATUS  

Set the patient status to “Excited” (after exercise) to increases heart rate, temperature, respiratory 
rate, tidal volume, O2, CO2 diffusion capacity, metabolic rate, and CO2 formation rate. Set the 
status to “resting” for a normal state. 

 

BLEED AND WOUND SIZE 

The Bleed and Wound size options simulate blood loss virtually. To start the virtual bleeding click 
the “Bleed” button, and then adjust the bleeding rate using the “Wound Size” control.  

 

Once the bleeding function is activated, the Auto Mode will adjust the vital signs in response to the 
blood loss. If the provider does not intervene, the vital signs will deteriorate and myocardial 
ischemia will occur. For information on how to infuse blood to the model virtually, go to page 71. 
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CARDIAC 

The Cardiac irritability control adjusts the cardiac rhythms indirectly. Set the Cardiac Irritability to 
“improve” to move the current heart rhythm to normal sinus gradually. Alternatively, set the cardiac 
irritability to “deteriorate” to move the heart rhythm to ventricular fibrillation and eventually asystole. 

 

The progression of rhythms generally follows the pattern displayed in the figure below, where “X” 
represents normal sinus rhythm, multifocal atrial tachycardia, atrial flutter, atrial fibrillation, 
junctional rhythm, left or right bundle branch block, or atrio-ventricular block:  
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Virtual Monitor 
The interactive virtual monitor tab (VM) displays the patient’s vital signs information in real time. 
The waveform and numerical parameters are interactive, and the layout is fully customizable. If the 
VM tab is not displayed by default, go to page 103 to activate the virtual monitor add-on. 

 

WAVEFORM MENU 

Click the waveform name to access the waveform options.  

 

 Freeze - Pause the waveform reading. To unfreeze the selection, click the waveform 
menu and select “Go”. 

 Time - Set length of the ECG waveform. The options available are 5 seconds, 10 seconds, 
15 seconds, and 20 seconds. 

 Display - Open the waveform properties menu. Edit the waveform color, amplitude, 
intensity and scroll direction. 

CHANGING THE WAVEFORM TYPE 

To change the type of waveform displayed, click the waveform menu and select “close”. 

  

Click the empty waveform menu and select the new waveform type. While operating on the 
Automatic mode, the ECG option displays a sub menu for 12 individual leads.  
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The new waveform type is now displayed 

 

NUMERIC MENU 

Click the numeric menu to access the numerical parameter options. To change the type of 
numerical parameter displayed, click the numeric menu and select “close”. 

 

Click the empty numerical menu and select the new parameter type. 

 

CHANGING VITAL SIGNS 

Numerical parameters can be adjusted directly from the virtual monitor tab. Double-click the 
numerical parameter to open the floating control window. Adjust the parameter to the new value 
and submit the changes using the Apply NOW or trending options. 
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NONINVASIVE BLOOD PRESSURE 

By default, the NIBP parameter does not update automatically. Click the NIBP menu and select 
“Stat” to refresh the reading. Alternatively, set a refresh interval to automate the stat process 
periodically.  
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Palette 
Use the Palette tab to sort, manage, and edit the palette items in the current profile. Each profile 
stores an independent library of palette items. 

To modify the vital sign parameters programmed into a palette, select a palette and click the Edit 
button. After the changes are made using the Details tab, click the “Save as Palette” Item button., 
See the Tips on Palette Item and Scenario Creation section of the appendix for more information 
on customizing palettes. 

Select a palette item from the list and click an a “Apply” button to update the vital signs to the 
values stored in the palette item. 
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Linear Scenarios 
Scenarios automate the vital sign changes, responses, and software actions required to carry out a 
complete simulation exercise. GIGA includes several preprogrammed scenario based simulation 
exercises in the “Quick Start Profile”. 

To use a preprogrammed scenario go to the Scenario tab and click “Load Scenario”. 

 

The Load Scenario dialog box appears. Select a scenario and click on Load. 

LINEAR SCENARIO OVERVIEW 

A linear scenario is a playlist of vital signs palette items played back in succession.  

 

During the scenario, each vital signs palette updates the patient’s vital signs. The palette’s 
transition time trends the increase or decrease of numerical parameters (e.g. Heart rate, blood 
pressure) over seconds or minutes. In the figure below for example, the vital signs palette “Healthy 
Resting” is programmed with a transition time of 2 minutes. When the scenario reaches “Healthy 
Resting”, it will take 2 minutes for the vital signs to trend from the previous state to the values 
programmed within the palette. 

 

Wait palettes do not update or change vital signs. Instead, wait palettes give the participant time to 
perform an action; this may be treatment in response to a complication or performing a standard 
assessment.  

Vital sign 

Palette items 

Wait 

palette 

items 
Progress 

indicator 
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SCENARIO CONTROLS 

Scenarios are controlled using the playback buttons at the bottom of the tab. Intuitively, the click 
play, stop, pause, or next as necessary during the scenario. Click next to proceed to the next 
palette from a “wait indefinitely” palette. 

 

SCENARIO QUICK LAUNCH 

Use the scenario Quick Launch tab to start a scenario with a single click. The Quick Launch tab 
displays all the scenarios saved in the active profile. 

 

CREATING A NEW LINEAR SCENARIO 

The general process of creating a new linear scenario is the following: 

 Create a vital sign palette item for each state in the scenario 

 Add the vital signs palettes and wait times to the scenario 

 Play the scenario 

 Modify and edit palettes 

 Save the scenario 

CREATING PALETTE ITEMS 

The first step is to create several vital sign palette items using the Details/Status panel. Each 
palette item represents a physiological state during the scenario. 

Program the first palette item to be used as the scenario’s starting point. Set values for all the 
physiological parameters, sound types, and volumes. This ensures that when the scenario begins 
no vital signs from a previous state will inadvertently carry into the scenario exercise.  

Reset 

Pause/

Play 

Next 

palette 

Previous 

palette 
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Using the list view controls, select the vital signs parameters for the starting physiological state in 
the scenario. Click the “Save as Palette Item” button to create the new palette. 

 

The “Save as Palette Item” dialog box is displayed. Type in the palette item name and a brief 
description; assign a color tag and click “Save”. 

 

Create the next palette item with only those vital sign parameters that are relevant to the second 
stage in the patient’s condition. Repeat this process to create palettes for the third and final stage in 
the scenario. Remember to program only the values that require change. After all the individual 
vital sign palettes are created, go to the “Scenario” tab and click “Add to Scenario”. 
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The Add Palette item menu displayed. Select the vital sign palette programmed to be first state in 
the scenario. Enter 0 min 0 sec for the transition time, so the initial vital signs are applied 
immediately. Click “Add” to add the palette to the scenario.  

 

The first palette is now added. Click “Add Palette to Scenario” button again to add more vital sign 
palettes and wait palette items. 
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A “Wait” item maintains vital signs values steady for the transition time allotted. Insert a “wait” item 
to give the provider time to perform an action or an assessment. For example, auscultating blood 
pressure or gathering general information about the patient. Alternatively, add “Wait Indefinitely” to 
hold the vital signs until the “next item” button is clicked from the playback controls. 

 

The wait palette item is now added.  

 

Add more palette items and then use the “Selected Item” menu to make any changes. 
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Click “Save Scenario” to store the scenario in the current profile for later use. 

 

Type in a name and a description for the new scenario and click Save. 

 

ADDITIONAL SCENARIO FEATURES 

Incorporate the following features into a scenario for added realism. 

 Auto responses –move onto the next palette item automatically when virtual electric 
therapy is detected 

 File sharing and lab reports – Send lab reports to the virtual monitor computer 

 Speech – add phrases or custom speech 
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FILE SHARING AND LAB REPORTS 

The scenario can also automate the distribution of shared files and labs. Click “Add to scenario”, 
and then use the “File” and “Lab” tabs to select from available documents. For more information 
making files available for file sharing, go to page 109. To create a new lab report, go to page 54. 

   

SPEECH 

Add realism to a scenario by integrating automated speech phrases. Click the Add to scenario 
button and select Speech. Then, select the type of speech and phrase using the drop down menus. 
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AUTO RESPONSES 

The scenario auto-response settings move the scenario to the next palette when electrical therapy 
is detected. Electrical therapy can be applied by the facilitator via Virtual Shock panel or by the care 
provider using real medical equipment if the simulator supports it. 

Auto-responses advance to the next palette if the virtual shock is applied while a “wait 
indefinitely” palette is playing and the heart rhythm is “shockable”. 

 

The three response options are defined below: 

 Off - The scenario does not respond to the electric therapy. 

 Prompt - The software detects the electrical therapy and prompts the user for approval before 
advancing to the next palette. 

 Auto – Advances to the next palette automatically only if the electrical therapy meets the 
threshold specified 
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Branching Scenarios 
Unlike linear scenarios, which move from one palette to the next, the trajectory of a branching 
scenario can change in response to the participant’s actions. Click the “Branching scenario” tab to 
access the branching scenario window. 

 

DEFAULT BRANCHING SCENARIOS 

Use the panel buttons to clear, load, and save new scenarios, or to switch from branching to linear 
scenarios. Click “Load Scenario” to access the preprogrammed branched scenarios in the current 
profile.  

 

CREATING A NEW BRANCHING SCENARIO 

The process of creating a new branching scenario is the following: 

 Add nodes  

 Add palettes or scenarios to each node 

 Add paths to nodes that require provider action 

 Create key events to alter the progress and trajectory of the nodes within the scenario 

ADDING NODES 

A branching scenario consists of several “Nodes”. Each node is preconfigured to run a normal 
scenario or a series of palettes simulating a specific condition or effect. Click the “Add node” button 
to create a new node for the first set of vital signs. 
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Click the node’s identifier number to edit the node properties. 

 

Enter a name for the node and description and then click “Save”. 

 

ADDING PALETTES OR SCENARIOS TO A NODE 

Click “Add Item” to add palette items or “Add Scenario” to add full scenarios to the node.  
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Add more nodes each with palette items to simulate every stage in the scenario. In this example, 
several nodes simulate the effects of medications that maybe administered to the patient by the 
provider. The first two nodes simulate the complication [1] Start Bradycardia, [2] Deteriorate. The 
following nodes: [3] Interventions, [4] Atropine, [5] Epinephrine, [6] Dopamine and [7] Pace are 
activated only when the provider administers the applicable medication or electrical therapy. Each 
node is programmed with palettes that simulate the effect described. 

 

ADDING PATHS 

A path refers to the trajectory from one node to another after the last palette in the node expires. 
The scenario will move on to the node indicated by the arrow. Click on the “Time Limit” icon to 
modify the “Go To” point for the default path.  
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In this example, the first node must move to “Node 2 - Deteriorate” after the time limit expires. Click 
“OK” to save the changes. 

 

Node 1 is now configured to proceed to Node 2 as indicated by the arrow. 

 

KEY EVENTS 

Key events activate alternate paths in a node. The alternate paths are used to change the 
trajectory of the scenario depending the participant’s actions. To add a key event to a node, first 
add the additional paths. 

 

Click the “Edit path” icon to program key events for the node. 
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A key event is the action expected by the participant. Type a name for the action and then click 
“Add”. 

 

After the action is added to the Key Events list, assign the node that this action will move the 
scenario to using the “Go to” menu. Click “OK” to save changes. 
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In the figure below, node 2 is configured with four alternate paths. Once the provider performs any 
one of the actions listed as key events, checkmark the key event to activate the alternate path. 

 

SAMPLE BRANCH SCENARIO DIAGRAM 

Node Node Name Description 

1 Start 
bradycardia 

Node vital signs palettes simulate bradycardia. Go to node 2. 

2 Deteriorate 

Vital signs palettes deteriorate the patient’s condition by -15%.  

Care provider has 4 options. Each option (key event) moves the scenario to 
the node specified. If no action is taken, the scenario will move to node 3 at 
the end of the time limit. 

Key event 

Atropine 

Node 4 

Epinephrine 

Node 5 

Dopamine 

Node 6 

Pace 

Node 7 

3 Intervention 

Wait indefinitely, vital signs are on hold. Provider is to intervene again. 

Key event 

Atropine 

Node 4 

Epinephrine 

Node 5 

Dopamine 

Node 6 

Pace 

Node 7 

4 Atropine 
Node vital signs palettes simulate the response to atropine. Time limit: Go 
to node 3 after 1 minute. 

5 Epinephrine 
Node vital signs palettes simulate the response to epinephrine. Time limit: 
Go to node 3 after 1 minute. 

6 Dopamine 
Node vital signs palettes simulate the response to dopamine. Time limit: 
Go to node 3 after 1 minute. 

7 Pace Vital signs simulate the effect of pacing. Scenario ends. 

 

LINKED ACTIONS 

A “Linked Action - key event” triggers an alternate path when electrical therapy is detected. Click 
the Linked Action radio button and select the available actions. Then, set the electrical therapy 
thresholds or number of shocks require to trigger the action. Click “add” to create the key event. 
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Set the “Go to node” from the drop down and click OK to save the changes. 

 

The key event is now programmed to move the scenario to node 8 if pacing is detected. 

 

The “Linked Action” model medication tab is exclusive to the automatic mode. Program the 
medication linked action to trigger an alternate path when the system detects that the specific 
medication has been administered to the simulator. 
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Hypoxia 
Use the Hypoxia tab to evaluate the effectiveness of provider intervention on an apneic patient. The 
model adjusts the cardiac, oxygen saturation, and cyanosis dynamically in response to effective 
ventilations. The model also responds to the administration of epinephrine and oxygen. 

 

HYPOXIA MODEL STATE  

The hypoxia model options improve or deteriorate the cardiac and respiratory vital signs gradually.  

 Pause - Model will pause at the current state. 

 Improve - Trend the vital signs to a healthy state.  

 Deteriorate - Trend the vital signs to a severe cyanotic state. Ventilations are detected 
when the respiratory rate is at 0. 

CYANOSIS LEVELS 

Select the cyanosis level to move to any of the following states immediately: 

 Healthy - Pedi is pink with adequate oxygenation. 

 Mild Cyanosis - Pedi is slightly blue, and the vital signs are starting to deteriorate. 

 Severe Cyanosis - Pedi is blue, apneic, and vital signs are rapidly worsening. 

MODELED THERAPY 

The modeled therapy menu provides additional intervention options.  

 Improve Gain - Adjust the slider to increase or decrease the cyanotic response to 
ventilations. 

 Oxygen - Adjust the slider to administer oxygen to the fetus in liters per minute. 

 Epinephrine - Administer epinephrine to the model. Set the epinephrine dose and then 
click “add”. Administering epinephrine increases the heart rate. 

 Reset - Click “Reset” to clear the oxygen flow and the epinephrine dose onboard. 
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Lab  
Use the Lab tab to create mock laboratory tests results to aid the participants during simulation. In 
addition, create new laboratory templates to supplement different types of scenarios. Once a 
laboratory report is created, send the file to the virtual monitor screen for the provider access during 
the exercise.  

 

CREATING A LAB REPORT 

To create a new lab report with mock test results: 

 Click “Create a New Lab Report” on the right panel. 1.

 

The “Edit Lab Report” window is displayed. 
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 Select a “Lab Template” from the drop down menu. 2.

 

 Enter a report name, a report time, and a description. In addition, select a color tag for the lab 3.
report on the right panel. Color tags aid the sorting of lab reports on the report list window. 

 

 Enter the test results in the “Value” column. Include any comments associated with the test 4.
performed. 

 

 Click “Save” to create the lab report. 5.
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The newly created lab report is now listed in the “Lab Reports” section. Sort lab reports by name, 
template, description, or color tag. 

 

 Click “Preview” to review the final lab report. 6.

 

The preview window displays the test results how the provider will see them on the virtual monitor 
screen. If the computer is connected to a printer, click PRINT to create a hard copy. 
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SEND TO MONITOR 

Send the completed lab report to the virtual monitor screen to assist the care provider.  

To transfer the lab report to the virtual monitor screen: 

 First, select the report from the lab reports list. 1.

 

 Click “Send to Monitor” button to transfer the lab report to the virtual monitor. 2.

 

 An exclamation icon notifies the provider a file is ready for access on the Gaumard Monitors. 3.
Instruct the participant to click the patient menu drop down and select the lab report. 
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 The lab report opens using the system’s default application. 4.

 

 The letter Y represents a shared document. Click the “Stop Sharing button” on the right panel 5.
to remove the lab report items from the Gaumard Monitors menu.  

 

An editable copy of the lab report is stored inside the Gaumard_UI folder on the computer’s home 
screen. Go to page 109 for information on how to access other files from the Gaumard Monitor 
screen. 
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CREATING A LAB TEMPLATE 

Build new lab templates to supplement new scenarios.  

To create a new laboratory test template:  

 Navigate to the bottom of the tab and click “New Template”. 1.

 

The “Edit Lab Results Template” window is displayed. 

 

 Enter a name for the new template followed by a description. 2.

 

 Create categories to group a series of tests in a lab report. Click “Add” to create a new 3.
category. 

 

 Enter the name of the category and click “OK”. 4.
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 Click “add” on the “Single Entry” menu to create a new test under the current category.  5.

 

 Enter the name of the test, the unit, and decimal precision. 6.

 

 Enter a “Normal Range” the provider to reference. The normal range is visible on the lab 7.
report. The “Allowed Range” restricts the minimum and maximum value that can be entered a 
test result. Click “OK” to add the new test. 
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 Repeat the process to add more tests and categories. Click “Save” to create the new lab 8.
template. 

 

The new template is listed on the “Lab Template” section at the bottom of the Lab tab. Use the 
buttons on the left panel to edit or delete lab templates. 
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Speech 

PRERECORDED SOUNDS 

Select the Speech tab to command the simulator to speak aloud. The collection of speech and 
other sounds covers a wide range scenarios. In addition, use the streaming voice option to speak 
as the simulator’s voice and listen to the student responses. 

 

Click the phrase button to have the simulator speak the phrase aloud. Alternatively, program the 
phrases into a scenario to have the simulator speak automatically (page 63). 
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STREAMING AUDIO 

Use the streaming voice to speak as the simulator’s voice and engage the provider in a realistic 
conversation. In addition, record and save custom phrases to be played back during scenarios 
automatically. 

Ensure that the headset and microphone is connected to the PC before starting the GIGA software. 
The headset minimizes echo and environmental noise to improve audio quality. 

  

Click the “talk” icon and speak in to the headset to talk as the simulator’s voice. 

 

To listen to the provider’s response, click “Listen”. 

 

VOICE ACTIVATION 

Enable the “Voice Activation” feature to switch to the talk mode when voice input is detected 
automatically. Adjust the mic threshold to set the voice activation sensitivity. The higher the 
threshold, the less sensitive the microphone is; and vice versa. For instance, if the threshold is set 
to high, the voice input volume must be high to trigger the voice activation.  
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VOICE CLARITY 

Voice clarity can be affected by several factors. To improve audio for the listen and 
talk options please review the following information. 

 Connect the headset to the computer before activating the Gaumard control software 

 Connect to the simulator using the strongest channel. Assign separate channels to each 
simulator if working with multiple simulators at a time. 

 Adjust the physical mic control attached to the headset cable. 

 Adjust the streaming voice “Output Gain” To raise the output gain in increments, tap and 
hold the control, then slide to the desired level. Higher gain levels increase the talk volume 
but degrade the audio quality. 

 Fine-tune the Windows® microphone settings.  

RECORDING NEW PHRASES 

Create a library of custom recordings to play back as the simulator’s voice using the “Prerecorded 
Speech” feature. 

 

VOICE RECORDER 

To record a new custom phrase: 

 Click the “Rec” button and speak into the microphone. 1.

 

 Press “Stop” to finish recording.  2.
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 Enter a name and click “OK.”  3.

 

 The new phrase is listed under the “Prerecorded Speech” menu. 4.
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Medication (Auto Mode) 
The Medication tab is exclusive to the automatic operating mode. Use the medication controls to 
simulate the physiological effects and reactions of medications administered to the patient model. 
To simulate the effects of a medication, the GIGA software processes the drug’s properties, 
dosage, and interactions, and then adjusts the patient vital signs accordingly. 

The Meds Profile includes a library of preprogrammed drugs. The built in drug editor allows 
facilitators to stay current with new medications or make changes to the properties of the existing 
drugs. All of the preprogrammed drugs included in the Med Profile library are found in the 2008 
Handbook of Emergency Cardiovascular Care published by the American Heart Association.  
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ADMINISTERING A MEDICATION 

Follow this guide to administer a medication directly from the medication tab. If the simulator is 
equipped with a Drug Recognition Arm, reference the directions for use guide for information on 
how to administer medications using the tagged syringes. 

To administer a medication from the Medication tab: 

 Select the medication from the Drug drop down menu. 1.

 

A brief description is displayed at the top of the window. The half-life, peak time and drug 
concentration values are listed in addition to the standard and over dose dosage.  

 

 Enter the dose, units, route and rate (if applicable), and click “Administer”. 2.

 



Pediatric HAL S3005 | User Guide | 69 

 The “Proceed Drug” window prompts to confirm the dosage effects before applying them. 3.
Adjust the peak effect percentage and/or the dosage effect, and then click “Yes” to apply the 
effects 

 

To turn off the Proceed Drug prompt, click Setup>Auto Responses and change the Drug Model 
Effect settings to “Auto”. 

The administered drug panel displays information on dosage rate, does administered, and total 
time of administration.  
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The Auto mode adjusts the patient’s vital signs to simulate the effects of the drug automatically. 

 

The blood pressure continues to decrease in response to the medication’s properties. 

 

 Increase the “Rate” factor to speed up the effect of a medication on the patient model. 4.

 

 Right click on the drug entry to access additional options. 5.

 

Select from the following options. 

 Unselect - Unselect a highlighted drug 

 Current Effects - View the effect on the patient’s vital signs 

 All effects - View all the available programmed drug effects for this medication 

 Drug effect toggle -Turn the drug effects on the patient model on or off 
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REMOVING A MEDICATION 

Drugs cannot be removed from the list during the administration process with the exception of IV 
infusions. To stop an IV infusion before it is finished, highlight the medication from the list, and click 
stop. 

 

After the dose administration is complete, select the drug and click “Remove from list”.  

 

To remove all the medications from the list and reset the effects on the patient model, click “File > 
New Session”. 

 

FLUID & GAS 

The automatic mode can process the administration of gas and/or fluids to the patient model.  

 

Select from saline, blood, or oxygen and the volume/concentration and rate. Click on “Start” to 
administer. 
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DRUG LIST MANAGER 

Click the “Manage Drug List” button to open the “Add New Medication…” manager.  

 

Use the “Add New Medication” manager to add new medications, edit medication properties, 
update existing items, and program medication interactions.  

 

Select a medication from the Medication List and click “edit” to view the medication’s properties. 
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CREATING NEW MEDICATION 

Each medication is programmed with two palette items. One palette item is programmed with the 
vital signs adjustments to simulate the effects of a standard dose (SD), and the other palette item is 
programmed with the effects of an over dose (OD). Additional information such as half-life, peak 
time, and route is also programmed into the medication properties. 

When the medication is administered to the patient, the software applies the palette item 
associated with the dose threshold. The Auto Mode adjusts the vital signs changed by the palette 
item gradually to simulate the medication’s effect on the patient. 

To create a new medication: 

 Create a palette item using details page for the effects of a standard dose (SD). Then, repeat 1.
the process to create a palette item for the effects of an over dose (OD). For general 
information on how to create palette items, please go to page 27. 

  

 After dose effect palettes are created using the Details controls, go to the drug tab and click 2.
the “Manage Drug List” button. 
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The Add New Medication window is displayed. 

 

 Type the name of the new medication ( e.g. Generic Name (Brand Name)) and enter the 3.
medication’s description and the dosage information 

 

 Select the units and the administration route. 4.

 



Pediatric HAL S3005 | User Guide | 75 

 Enter the drug’s Half Life and Peak time. 5.

 

 Enter half-maximal effective concentration. 6.

 

 Select the standard dose (SD) effect palette created earlier and then click the applicable 7.
dosage button to assign it to the threshold. Repeat this step to assign the over dose (OD) 
effect palette to the Over Dose threshold.  

 

 Select the threshold unit and set the dosage amount that will trigger the programmed palette 8.
effect. 
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 Click “Add” to save the new medication to the Medication List library. 9.

 

DRUG EFFECT TESTER 

After configuring the drug properties using the “Add New Medication...” menu, click the “Update 
Graph” button to generate the effect-plasma concentration results. Continue to the next section to 
program interactors for this drug. 
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DRUG INTERACTION EDITOR 

Use the “Interaction Editor” window to program drug interactions. When two or more medications 
preprogrammed to interact are administered, the physiologic model will adjust vital signs to 
simulate interaction effect. 

 

Click “Drug Interactions” on the “Add New Medication…” window to open the Drug Interaction 
editor. 
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PROGRAMMING INTERACTORS 

To program one or more medications to interact with the current drug: 

 Select the interactor from the drug list click “Add”:  1.

 

Information about the interactor drug is displayed in the Interactor Data window. 

 

 The drug is included into the interactors list. Repeat the process to add more drugs to the 2.
interactors list if necessary. 
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 Select the interactor and click “Edit” 3.

 

 Adjust the Max Alpha to modify the type of interactivity effect. Monitor the graph for a visual 4.

model of the plasma concentration. 

 Alpha = 1: Additive 

 Alpha < 1: Synergistic/Induction 

 Alpha > 1: Antagonistic/Inhibition 

 

TEST PANEL 

Use the test panel to simulate the interaction between the drugs based on dosage and time of 
administration. 
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To simulate the medication interactivity using the test panel:  

 Enter the patient’s weight and the dose for each drug. 1.

 

 Enter the time of administration for each drug and click “Update Graph”. 2.

 

The results indicate that the maximum interaction effect (82.39 %) occurs at 00:46:51. The alpha at 
that point is 1.01 and the drug effect for each drug is reduced by 0.90%. Fine-tune the Max Alpha 
control and retest if the drug interaction effect is not realistic. 

 

A time-effect graph is generated from the test results. Tap and hold to draw a zoom area. 
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 Right click anywhere on the graph access the zoon and print options. 3.

 

 Click “Confirm” to save the settings. 4.

 

 Review all the properties of the new medication in the “Add New Medication…” window, and 5.
click “Add” to save the new changes. 

 

In the example below, two drugs preprogrammed to interact have been administered. The 
interaction information is listed in the Interaction Status panel. 
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Event Log 
The event log records a time stamped entry of events that occur during the simulation session. It 
addition, every individual entry records a snapshot of the vital signs parameters at the time the 
event occurred. The text log records the following events: 

 Vital sign changes applied manually or made by scenario 

 Events detected by onboard sensors (e.g. intubation sensor, defibrillation sites) 

 Preprogrammed speech phrases 

 Satisfactory or unsatisfactory evaluation  

 Facilitator notes 

 

Select an entry from the list and right click to view additional options. 

 

Select “patient vital signs” options to view a snapshot of the vital signs values when the event 
occurred. 
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ADDING NOTES 

Enter notes into the “add to log” field to record notes manually. The information is categorized in 
the log as “NOTE”. 

 

CREATING A NEW SESSION LOG 

The log event “time stamps” reference the GIGA session clock. At the start of a new simulation 
exercise, click File>New Session to reset the session clock 00:00:00, reset any vital parameters 
settings, and clear all the event entries. 

 

SAVING THE LOG INFORMATION 

The log information is recorded in a rich text format. Export the log information to save a detailed 
history of the events that occurred during the session.  

To save the session log report as a text file: 

 Click FILE>Save report 1.

 Enter a name for the report 2.

 Select the desired name and path, and click “Save”. 3.
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Provider Actions 
Use the Provider Actions tab to track actions performed by the provider manually. Each option on 
the Provider menu generates a time stamped entry in the text log below.  

 

SESSION INFORMATION 

Enter the session tile information and the name of the facilitator at the start of the session. The 
information is included in the final log report. 
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TEAM LOGGING 

The team logging feature is used to track the individual actions of up to six providers manually. The 
feature records the name of the provider with the action as an event entry in the log. 

To add a new provider to the Provider Actions” window: 

 Click Add” button to add a new provider. 1.

 

 Enter the provider’s name and select a color tag. Click OK to save the provider. 2.

 

 The provider is now added to the log tab. Repeat the steps to add up to six different providers. 3.
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TRACKING PROVIDER ACTIONS 

Provider actions can be tracked as a team or individually. Click the provider’s name to set the 
provider as active and track the actions individually. 

 

Click the appropriate option to track the action. For example, if the provider assesses the patient’s 
responsiveness by requesting them to open their eyes, click the “Assess responsiveness” button 
and select “Open your eyes”. 

 

The following log entry is generated with the name of the active provider who performed the action: 

 

Click the “Team” button to deactivate the active provider and return to general logging. Right click 
the provider button to delete or rename a provider. 
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CREATING NEW PROVIDER ACTION BUTTONS 

Create new clickable provider action buttons to expand the library of actions. To add a new action 
to an existing category: 

 Click the + button on the category 1.

 

 The category menu is displayed 2.

 

 Enter the name of the action and select the type of action 3.
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 Enter a description for the possible action and click + to add. Repeat the process to add 4.
several actions.  

 

 Click OK to save 5.

 

The new action is listed in the airway category. 
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Evaluation Form 
The evaluation tool assists facilitators in reporting and assessing provider interaction using a 
questionnaire form. A completed evaluation form can then be stored as a digital document or 
printed for distribution. 

 

COMPLETING AN EVALUATION 

Several preprogrammed evaluation templates included in the GIGA software. Each template 
includes a set of multiple-choice questions, fill in the blank, and true or false questions for a variety 
of scenarios.  

Select an evaluation template from the “Load template” drop down to begin. 

 

Enter the name of the facilitator administering the evaluation in On-Site Reviewer field. 
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Complete the form by answering each question. 

 

Click “Print” at the top right corner of the screen once the evaluation is completed. 

 

Select the Microsoft XPS Document writer to save the finished evaluation as digital document. Click 
“Print” to save the digital copy in the system. 
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Enter a name for the evaluation and click “Save”. 

 

PRINTING AN EVALUATION 

If the PC is connected to a printer, select and open the evaluation document saved in the previous 
step. 
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Navigate to the XPS Viewer file menu and select “Print”. 

 

Select the printer device from the list box and click print. 

 

It is recommended that documents be first saved as XPS files before being printed into hard 
copies. 
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CREATING AN EVALUATION TEMPLATE 

Create new evaluation templates for new scenarios using the edit mode. To enter the edit mode, 
toggle the “Go To button” located on the top right of the evaluation form window. 

Enter a name for the new evaluation template in the “Evaluation Name” field. 

 

Click “Add” on the Category menu. 

 

Select the category type and enter the category title. Click OK to save. 

 

The new category is now created. 
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Highlight the new category and then click “Add” on the “Multiple Choice Entry” menu.  

 

Type the evaluation statement in the new multiple choice field.  

 

Repeat the previous steps to add more categories, questions, and multiple-choice options. 

 

After the evaluation template design is complete, click Save at the top of the window. 
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The evaluation form is now available for use. 

 

 



96 | Pediatric HAL S3004 | User Guide 

CPR 
GIGA features a CPR performance evaluator 
and trainer. Click the CPR icon on the vertical 
menu bar to open the CPR window. 

 

The CPR evaluator feature provides real time 
feedback on the provider’s compression and 
ventilation performance. 

 

The provider performance indicator boxes are 
located on the right. The V (ventilation) and C 
(compression) box fill color changes between 
the following states: 

 

 Grey – No intervention was detected. 

 Yellow – Compression was too shallow. 

Ventilation was too weak. 

 Green – Compression/ventilation was 

performed correctly. 

 Red – Compression was too deep. 

Ventilation was too strong. 

Compression and ventilation data is displayed 
at the bottom of the window as CPR is 
performed by the provider. 

 

Compression Data 

 Rate – Rate of compressions in real time. 

 Ct – (Compression time) – Average length 

of each compression in seconds. 

 LC – (Last Compression) – Time elapsed 

since the last compression performed. 

Ventilation Data 

 Rate – Ventilation rate in real time. 

 PIP – (approx.) Peak Inspiratory Pressure 

 Ti – Time Inspiration 

 I:E – Inspiratory: Expiratory Ratio 

 PEEP – (approx.) Positive end-expiratory 

pressure 

 LV – (Last Ventilation) – Time elapsed 

since the last ventilation performed. 
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CPR TRAINER 

The CPR trainer reference boxes generate a 
visual prompt of the compression to ventilation 
ratio programmed in the “CPR Options” menu. 
Click the “Trainer” button to start. The V 
(ventilations) and C (compressions) box 
borders blink to indicate the correct reference 
CPR rate. 

  

CPR OPTIONS 

By default, the CPR trainer is configured to 
blink the reference borders at a 30:2 
compression to ventilation ratio. To change the 
ratio, navigate to the menu bar and click the 
CPR dropdown and CPR Options. 

 

PERFORMANCE EXAMPLES 

Compressions are too shallow. Waveforms 
mostly do not reach the green zone. 
Compression indicator is yellow. 

 

Compressions are too deep. Waveforms 
mostly exceed the green zone. Compression 
indicator is red. 

 

Compressions are performed correctly. 
Waveform peaks are mostly inside the green 
zone.  

 

Ventilations are too shallow. Waveform peaks 
do not reach the green zone.  

 

Ventilations are too strong. Waveform peaks 
exceed the green zone. 

 

Ventilation was performed correctly. Waveform 
peak is inside the green zone. 
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Menus 

File 

 

PROFILE 

Click the Profile menu option to open the 
Profiles menu. To switch to a different profile, 
select the operating mode and the new profile 
and click “Load”. 

NEW SESSION 

Clicking New Session in the file menu will: 

 Clear any loaded/playing scenario 

 Clear any loaded/playing palette 

 Reset vital signs to normal values 

 Clear out log page 

 Restart the session clock.  

The session clock is located at the bottom of 
the dialog box. 

 

The shortcut key for staring a new session is: 
Ctrl + N 

RESET SESSION CLOCK 

Clicking on Reset Session Clock resets the 
clock back to zero. It does not have any effect 
on the transition time remaining on a scenario; 
it does not reset the vital signs, or clear out 
loaded scenarios. The facilitator can also reset 
the session clock by clicking on the Session 
button next to the session time. 

 

SAVE REPORT 

This option allows you to save all the 
information recorded in the log page as a text 
file. Clicking on it brings up the “Save As” 
dialog box: 

 

Select the desired name and path, and click 
“Save”. 

The shortcut key for saving a report is Ctrl + S. 
For a sample report, look at the figure below: 
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PRINT REPORT 

This option allows you to print a text file 
containing all the information in the log for the 
latest session. Clicking on “Print Report” brings 
up the Print dialog box. The shortcut key for 
this option is Ctrl + P. 

IMPORT 

Use the “Import” menu to import palettes, 
scenarios, and modeling patients created on 
another PC or stored in a backup location. 

To import an item into GIGA: 

 Click File>Import on the menu to access 1.
the “Open” menu.  

 Set the type of file to import. 2.

 

 Browse to the location where the item is 3.
saved and click “Open” to import. 

 

The scenario file is copied to the GIGA 
scenario library automatically. 

EXPORT 

Use the Export feature to backup palettes, 
scenarios (branched or linear), and model 
patients files. 

To export an item and save it to a location on 
the computer: 

 Click File > Export to open the “Export” 1.
menu  

 Select the file type from the “Export File 2.
Type” drop down menu: 

 

 Select the item to export from the list and 3.
click “Export” 

 

The “Save As” window is displayed. 

 

 Browse to the location where the file will 4.
be saved and click “Save”.  

 

EXIT 

Click File > Exit to close the GIGA software 
and turn the simulator off. Alternatively, click 
the power bottom and click the X icon near the 
top corner of the screen. 
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Set-up 

 

CALIBRATION 

Use the Calibration menu to calibrate the 
simulator’s features, and to reset the sensors 
back to default settings. Reference the 
simulator’s directions for use guide to 
determine which feature calibrations apply. 

 

Chest rise will stop when the 
“Calibration” menu is active. 

 Chest compressions 

 Artificial Ventilations 

 Blood Pressure Cuff 

CHEST COMPRESSIONS  

The chest compression calibration wizard 
records the average depth (as pressure) of 5 
chest compressions. GIGA evaluates provider 
performance using the information recorded 
during the calibration as the correct 
benchmark. 

To calibrate the compression performance 
benchmark: 

 Click Setup > Calibration > Chest 1.
Compressions, and click “Next” 

The wizard prompts to perform 
compression “#1” 

 Perform one chest compression correctly. 2.
A green filled oval indicates that the chest 
compression was recorded successfully. 

 Perform chest compression # 2 as 3.
prompted by the wizard. A green filled 
oval indicates that the chest compression 
was recorded successfully 

 Continue the calibration process to record 4.
a total of 5 compressions as prompted by 
the wizard 

At the end of the calibrating session, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the settings.  

Please test the compressions 
calibration using the CPR trainer. Go to 
page 96 learn more about the CPR 
trainer and the feedback graphic. 

VENTILATIONS 

The ventilation calibration wizard records the 
average pressure of 5 ventilations. GIGA 
evaluates provider performance using the 
information recorded during the calibration as 
the correct benchmark. 

To calibrate the ventilation performance 
benchmark: 

 Click Setup > Calibration > Ventilations, 1.
and click “Next” 

The wizard prompts to perform ventilation “#1” 

 Perform one ventilation correctly. A green 2.
filled oval indicates that the chest 
ventilation was recorded successfully 

 Perform ventilation # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the ventilation was recorded 
successfully 

 Continue the calibration process to record 4.
a total of 5 ventilations as prompted by the 
wizard 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the settings.  
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Please test the ventilation calibration 
using the CPR trainer. Go to page 96 
learn more about the CPR trainer and 
the feedback graphic. 

BLOOD PRESSURE CUFF 

Calibrate the Blood pressure cuff feature if the 
Korotkoff sounds do not match the systolic and 
diastolic values set using the GIGA controls. 
Reference the simulator’s directions for use 
section to calibrate this feature. 

FACTORY SETTINGS 

Use the Factory Settings menu to restore 
sensors settings back to the factory default 
values. Resetting the sensors deletes all 
current calibration settings. 

 

Remove all adjuncts, or peripherals that 
may alter the neutral state of a sensor 
prior to resetting it. 

Click the sensor button to reset it to the factory 
setting. Please reference the directions for use 
guide for troubleshooting information. 
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OPTIONS 

Navigate through the Options menu to 
configure software settings and enable 
additional features. 

 

ENVIRONMENT 

The environment tab is used to configure the 
connectivity options. Select the “GENERIC” 
option to scan and connect to the nearest 
simulator. Alternatively, select the FIXED 
option and enter the simulator’s serial number 
to connect to a specific simulator only. The 
FIXED mode is required to enter activation 
code for upgrade features. 

 

GENERAL 

This tab allows the facilitator to: 

 Enable auto saving of the log 

 Save your current log report 

 Enable stand-by warning 

 Select units (SI or English) 

 Enable electrical therapy shock panel 

The shock panel is a floating window used to 
apply electrical therapy to the patient virtually. 
Go to page 46 for more information on how to 
work with the “auto responses” feature and the 
virtual shock panel. 

 

Click the lightning icon to open the 
“Shock/Pace” panel. 
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PEDIATRIC FEATURES 

Customize the following simulator specific 
features: 

 Fine-tune the pulse intensity for normal 
blood pressure. 

 Configure the systolic threshold for each 
pulse. 

PEDIATRIC ADD-ONS 

Activation codes enable upgrade and 
additional software features.  

Activation codes are unique to the simulator’s 
serial number. Before entering a code to 
activate a feature, go to the Environment tab, 
set the connectivity mode to FIXED, and enter 
the simulator’s serial number.  

 Virtual Monitor - Enables the “Monitors” 
menu option to configure the virtual 
monitor connection. 

 Automatic Mode – Enter the Automatic 
Mode activation code to enable the 
automatic operating mode option in the 
profile menu. 

PACING 

GIGA can detect small variations in the heart 
rate and current during pacing. Each variation 
could trigger a programmed auto response or 
create a new entry in the log event. Adjust the 
threshold for each parameter so only the 
changes greater than the ones specified will 
be detected by the GIGA software. 

 

CPR OPTIONS 

Configure the CPR trainer parameters to meet 
the most current CPR standards. 

 

 Ventilations and compressions - Set the 
trainer’s ventilations to compressions ratio 
prompt 

 Ventilations only - Set the trainer to 
prompt for ventilations only, and set the 
rate per minute. 

TOLERANCES 

Use the Tolerances controls to adjust error 
margin allowed by the CPR intensity and rate. 

The simulator’s pupils react to light. Use the 
“Pupil Sensitivity” controls to recalibrate the 
pupil reaction if dilation is erratic. 

 Set ambient light - Click “Set ambient 
light” to recalibrate the pupil diameter to 
the current ambient light. 

 Set Dilation Light - While covering both 
eyes from most incoming light, click "Set 
Dilation Light" to set the low light pupil 
diameter. 

 Increase/Decrease Sensitivity - Click 
increase or decrease to adjust the pupil’s 
sensitivity to light 

 Reset to Default: Reset the pupils’ 
ambient and dilation settings to the factory 
settings. 
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LOG 

Log event text entries are color-coded. Use the 
log tab to customize the color of each log entry 
type. 

 

OTHER 

Checkmark "Once a 'Palette' is applied load to 
“Details Tab'" to show the value of each 
palette’s vital signs parameter on the Details 
tab control fields. 

Checkmark the “Link respiration sensor to 
ECG leads sensors” to generate artifacts with 
each compression. 

Checkmark the “Use A/V” to display the audio 
and video configuration menu on the menu 
bar.  

 

REMOTE ACCESS VIA NETWORK 

The “Remote Access via Network” feature 
allows GIGA to communicate with the 
simulator remotely using the virtual monitor PC 
as the RF transmitter. The alternate 
configuration may provide better connectivity 
in environments with numerous walls or 
obstructions between the simulator and the 
control PC. 

 

The USB RF module drivers must be 
installed on the virtual monitor PC 
before the “Remote Access via 
Network” feature can be configured.  

Go to www.Gaumard.com to download 
the latest USB RF module drivers using 
PC with internet access. Do not connect 
the Virtual Monitor PC to the internet. 
Transfer the USB RF module setup file 
to the virtual monitor PC using a USB 
drive and complete the installation. 

To configure the “Remote Access via Network” 
connection: 

1. Connect the simulator’s USB RF module 
an available USB port on the virtual 
monitor PC 

http://www.gaumard.com/
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2. Verify that both computers are connected 
to the ad-hoc network (e.g. GaumardNet,) 

3. Initialize GIGA on the tablet PC open the 
Remote Access via Network menu from 
the Setup menu 

4. Select the Remote access via network 
radio button 

5. Verify that Wireless Network Connection 
is selected from the adapter list 

6. Click “Find available” to auto configure the 
port used for this connection 

7. Write down the controller IP and port 
number, then click “Connect” 

8. Navigate to the V menu on the virtual 
monitor computer and select “Remote 
access Via Network” 

Please wait 30 seconds for the feature to 
initialize 

9. Enter the “controller IP” and “port number” 
as shown on step 7 and click “connect” 

AUTO RESPONSES 

The Non-Scenario Automatic Response 
feature allows the facilitator to set 
preprogrammed responses to electrical 
therapy events. When the electrical therapy is 
detected, auto-responses can automatically 
load a specific palette item or prompt the 
facilitator before making preprogrammed 
changes to the simulator’s vital signs.  

Non-scenario response settings detect 
electrical therapy administered when a 
scenario is not in progress. For information on 
how to configure auto-responses for use 
during a scenario, go to page 46. To activate 
the virtual shock panel for administering 
electrical therapy virtually, go to page 102. 

 

The behavior of each auto response option is 
explained below: 

 Off - The software does not respond to the 
electric therapy 

 Prompt - The software detects the 
electrical therapy and prompts the 
facilitator before applying the changes 
configured in the “Settings” section. 

 Auto - The software automatically detects 
the electrical therapy and compares it to a 
threshold selected by the provider. If the 
threshold is met, the vitals will 
automatically change to the parameters 
specified on the “Settings” section. 

Each type of electrical therapy has a unique 
set of default parameters. For example, the 
default response to a defibrillation Shock 
applies the following vital sign parameter 
changes: NSR, 75 bpm, BP 120/80. Click the 
palette button to program a specific palette 
item as an auto-response. 
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Select the desired palette from the “Load 
Palette Item…” window and click “Load”. 

 

The defibrillation shock auto-response is now 
configured apply the “Healthy Resting” palette 
if a virtual defibrillation shock of 200 Joules or 
greater is detected. The programmed 
response palette is listed in the “settings:” 
panel. 

 

AUTOMATIC MODE NON-
SCENARIO AUTOMATIC 
RESPONSES 

The “Automatic Mode non-scenario Automatic 
Responses” are unique to the automatic mode. 

Link All Auto Response to Cardiac Irritability - 
Auto-responses will work only if the cardiac 
irritability option on the details page matches 
the selection on this window.  

 

An event prompt is displayed if electrical 
therapy is detected and the cardiac irritability 
set does not match the selection on the 
responses window.  

Drug Model Effect – Configure the auto-
response behavior for drug administration. 

 Auto – Apply the drug effects based on 
medication’s programmed properties and 
dosage  

 Prompt – Display a confirm prompt before 
applying the drug’s effects 

SCAN RF CHANNELS 

Use the Scan RF Channel tool to search for 
the strongest RF communication channel 
available.  

Click the “Scan RF Channels” 
option in the setup menu to start the scan. 
Please wait while the system completes the 
process. 

The tallest bar represents the strongest 
channel. Double click the bar to connect to the 
simulator using the channel selected. 
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Auto Mode (Upgrade) 

The “Modeling” drop down menu in the top left 
corner of the GIGA contains four options: 
Modeling Patient, Reset Model, Import 
Between Patients, and Auto Log Setting. 

 

MODELING PATIENTS 

This option allows you to create a new patient 
or load an already existing one. 

 

To create a new patient, go to Modeling, 
Modeling Patient, new patient. The following 
dialog box is displayed: 

 

Enter the name of the patient, age, gender, 
height, weight, and/or additional notes. Then, 
click “Save”. 

To load an already existing patient, go to 
Modeling, Modeling Patient, Load Patient. 

 

Select the desired patient, and click on Load. 
Notice that the factory pre-set patient cannot 
be deleted, as opposed to any of the patients 
that you create yourself, which can be deleted. 

Patient information is displayed on the right 
side and near the top of the Details tab. 

RESET MODEL 

Clicking on Reset Model under the Modeling 
drop down menu, will restore all vitals and 
physiologic controls to normal state. For 
instance, if the ECG rhythm is currently on 
Ventricular Fibrillation, clicking on reset model 
changes the ECG rhythm back to sinus.  

IMPORT BETWEEN PATIENTS 

Use the “Import between patients” menu to 
import palettes, scenarios, and branching 
scenarios from other patient profiles into the 
current active one.  

 

To import an item another patient in to the 
active patient:  

 Click Auto Mode> Import Patient to open 1.
the ”Import” menu 

 Select the item category to import 2.
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 Select the patient name that contains the 3.
items to be imported into the active patient 

 

 Select the items to import from the list and 4.
click “Import” 

 

The palettes are now copied into the active 
patient. 

 

AUTO LOG SETTING 

This menu option is used to specify various 
vitals to be logged automatically after reaching 
a specific threshold. 
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Monitors 

Use the Monitors drop down menu to 
enable/disable sensors on the virtual monitor 
screen, share files, program custom scalars, 
and verify the connection between the GIGA 
and Gaumard Virtual Monitor software. 

 

If the “Monitors” drop down is not 
showing, go to Setup>Options> Add-
ons, and checkmark “Use Virtual Vital 
Signs Monitor.” 

SENSORS 

Use the sensors option to enable or disable 
any of the waveforms displayed in the vital 
signs monitor. Select the waveform and click 
“ON” to display the readings on the virtual 
monitor screen. To disable a parameter 
reading, click “OFF”. The vital signs monitor 
sensors defaults to “All On.”  

 

Some sensors, such as NIBP and 
Thermometer feature a STAT control that will 
allow the facilitator to activate readings on the 
virtual monitors from the controller software. 

SENSOR CONTROL WINDOW 

The sensor control window is a floating panel 
with on/off toggle controls. Click Monitors> 
Sensors> Window to open the floating sensor 
control panel.  

 

Single click the circular icon to enable or 
disable the sensors displayed on the virtual 
monitor screen. Click the circle dark to disable 
the sensor and light blue to re-enable it. In the 
example above, all the sensors are on except 
the thermometer. 

FILE SHARING 

The file sharing menu allows the facilitator to 
send images, audio, and text files to the virtual 
monitor screen. Use the file sharing feature to 
fulfill file requests by the provider during 
simulation. 
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The files used for sharing are stored in the 
control PC. Before the simulation begins, add 
mock image (.jpg, .bmp) or text files (.txt) into 
the Gaumard_UI folder located on the home 
screen of the control computer. 

 

Open the “File Sharing” menu. 

 

The list of files stored on the Gaumard_UI 
folder available for sharing is displayed on the 
left panel. To share a file, select the file from 
the left panel and click “Add”. 

 

Enter a context name on the pop-up menu and 
click “OK” to share. 

 

Files currently shared are listed on the “Shared 
Files” list.  

 

A yellow notification icon is displayed on the 
patient menu at the top left of the virtual 
monitor screen. The icon notifies the provider 
that a file is available for viewing. Click the 
patient menu and select the file open it. 

 

The x-ray file is now open on the virtual 
monitor computer. 
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To unshared the file, select the file from the file 
sharing menu and click remove. 

 

To troubleshoot file sharing access errors, 
please reference the Gaumard Monitors user 
guide. 

CUSTOM NUMBERS 

Use the custom numbers feature to add 
custom numerical parameters to the Gaumard 
Monitors screen. For example, glucose levels 
or platelets count.  

On the GIGA menu bar click Monitors>Custom 
Numbers to open the “Custom Numerical 
Parameters on Monitor” menu. Click the “Add” 
button to create a new parameter. 

 

Type the name and units of the new parameter 
and then click “OK”. 

 

The scalar parameter is now created. Enter a 
value for the parameter and click “Update”.  

 

On the virtual monitor screen, click on a 
scalar’s menu and select “Close” to make the 
entry available for the custom parameter.  

 

The scalar entry is now a blank field. 

 

Click on the empty scalar menu and select 
“Other” from the list of available scalar 
parameters. Select the name of the custom 
parameter. 

 



112 | Pediatric HAL S3004 | User Guide 

The figure below shows two new values: 
Glucose level and hematocrit levels. Return to 
the custom parameter menu on the GIGA 
software to update the values when 
necessary. 

 

CONFIGURATION 

On the GIGA menu bar, click 
Monitors>Configuration to open the “Virtual 
Monitor Setup” window. Use the setup window 
to verify the connection between the GIGA 
software and the Gaumard Monitors vital signs 
software, re-configure the communication 
ports, and view the controller IP address. To 
troubleshoot connectivity issues between the 
two computers, please reference the Gaumard 
Monitors user Guide. 
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A/V (Audio & Video) 

GIGA is capable of interfacing with a number 
of third-party A/V recording systems. 
Generally, A/V solutions capture footage of the 
simulation and interlace it with the event 
information generated by the simulator control 
software. 

To enable the fetal Neo link menu option, go to 
Set Up > Options > Other and checkmark “Use 
AV System”. 

 

Click “Setup AV” to configure the software 
connection to the AV system. Enter a port 
number for the connection and click “Connect” 
to establish a link. Please contact the AV 
administrator for information on how to accept 
incoming connections from the GIGA software. 

 

Return to the A/V menu and click “Start AV” to 
initialize the recorder. Some third party A/V 
solutions may not recognize the “Start” 
command generated by the log event. If the 
recorder does not start remotely, please start 
the new video manually using the third party 
controls. 

The log event does not command the 
recording to stop at the end of the 
scenario automatically. Click Stop A/V 
from the menu to end the recording. 
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Help 

 

INSTRUCTION MANUAL 

Click the Instruction Manual option to open a 
digital copy of the latest “User Guide” 
information. 

ABOUT GUI 

Click “About GUI” to view the software version. 

 

CHECK FOR UPDATES 

Redistributable GIGA installer files are 
available for download at 
http://www.gaumard.com/software-updates/.  

To update the GIGA software using a flash 
drive: 

 Download the update file to a flash drive 1.
using a computer with internet access 

 Copy the setup file to the simulator’s 2.
control computer  

 Run the GIGA update file to update the 3.
software 

Do not change the wireless network 
settings. Doing so will disconnect the 
virtual monitor computer and the 
Gaumard Monitors vital signs software. 

To update the GIGA software using an 
Ethernet connection: 

 Connect an Ethernet cable to the laptop 1.
PC. 

 Click “Check for Updates”. 2.

 Click “Install” to begin the update. The 3.
download progress bar begins to auto-fill 
as the setup file is downloaded 

After the download is complete, the update 
setup wizard is launched automatically. 

 Click “Next”, and follow the wizard to 4.
complete the software download. 

DIAGNOSTICS 

The diagnostics menu is used to test the 
status of electronic and mechanical 
components in the simulator. 

Click “Check all Modules” to run a full systems 
check. Active modules report blue. Modules 
that are inactive or not installed report black. 

 

http://www.gaumard.com/software-updates/


Pediatric HAL S3005 | User Guide | 115 

Working with HAL 
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Features 
Disclaimer: The section below describes all possible features in the HAL simulator. The content of 
this table is subject to change without prior notice. Please contact Gaumard Scientific for the most 
current information.   Y = Yes included / O = Optional 

 Simulator Feature HAL 5 Year 
S3005 

HAL 1 Year  
S3004 

Airway Nasal Intubation Y Y 

Oral Intubation Y Y 

ET Tube Position Sensor Y Y 

Tongue Edema Y Y 

Cricothyrotomy / Tracheostomy Y Y 

Airway Sounds Y Y 

Breathing R/L Chest Rise Y Y 

R/L Lung Sounds Y Y 

Ventilation Sensor Y Y 

Cardiac Heart Sounds Y Y 

ECG Lead II Y Y 

Defibrillation/ Cardioversion / Pacing Y Y 

Compression Sensor Y Y 

Circulation Bilateral IV arms Y Y 

Blood Pressure (Left Arm) Y Y 

Bilateral Pulses (Carotid, Brachial, Radial, Femoral, 
Radial) 

Y Y 

Disable Radial Pulse Y Y 

Central Cyanosis Y Y 

Neurological Reactive Eyes Y Y 

Seizures Y Y 

Other CPR evaluation Y Y 

Intraosseous Access Y Y 

Intramuscular Injection Sites Y Y 

Urinary Catheterization Y Y 

Gastric Distention Y Y 

Bowel Sounds Y O 

Automatic Mode O O 

Streaming Audio O O 
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Airway 

AIRWAY COMPLICATION 

Use the software controls to enable the airway 
complications and make intubation more 
difficult. HAL can display tongue edema. 

NASAL AND ORAL INTUBATION 

Intubate HAL’s airway via the nasal or oral 
route using an endotracheal tube or an LMA. 

 

WARNING: Always lubricate the 
endotracheal tube and the medical device 
using silicone oil before intubating. Do not 
introduce liquids into the airway. Doing so 
can permanently damage the system.  

Procedure 5 Year - 
S3005 

1 Year - 
S3004 

Intubation 
(Blade size) 

Miller 2 or 
MAC 3 

Miller 1 

LMA Size 2/2.5 Size 1.5/2 

Nasal 
Intubation 

10  Fr catheter 10 Fr catheter 

Oral 
Intubation 

Lubricated 
ETT 5.0 or 5.5 
no cuff; 10 Fr 
suction 
catheter 

Lubricated 
ETT 3.5 no 
cuff; 8 Fr 
suction 
catheter  

Nasogastric 
Tube 

10 Fr catheter 10 Fr catheter 

INTUBATION SENSOR 

Sensors in the airway detect the placement of 
the endotracheal tube. If the endotracheal tube 
is inserted too deep, the left lung is 
automatically disabled demonstrating right 
mainstem intubation. Correcting the tube 
position enables the left lung chest rise. 

AIRWAY SOUNDS 

The simulator can produce airway sounds. 
Use the software controls to change the sound 
type and adjust the volume. Auscultate using a 
standard stethoscope. 

Cricothyrotomy/Tracheostomy 

Providers can perform a cricothyrotomy 
through the precut opening on the neck skin. 
The airway itself features an opening covered 
with tape that simulates the soft cricothyroid 
membrane. 

Avoid using surgical tools to cut the neck 
skin. The precut opening allows the 
insertion of most medical devices. Always 
lubricate the medical adjunct before 
insertion. 

 

REPLACING THE CRICOTHYROID 
TAPE 

To replace the cricothyroid membrane tape: 

1. Turn off the simulator and place it on a 
clean flat surface 

2. Unscrew the bolts located at either side of 
the midsection 

3. Gently slide the skin off each bolt and life 
the chest skin over the face to expose the 
airway 

4. Remove the punctured cricoid tape from 
the airway and any glue residue 

5. Wrap a new piece of tape around the 
airway to cover the cricoid opening. 
Ensure that the tape provides an airtight 
seal to prevent air leaks 
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Breathing 

BILATERAL CHEST RISE 

Bilateral chest rise and fall is automatic. Use 
the software controls to enable or disable the 
lungs independently and to adjust the 
breathing rate and the inspiratory percentage. 

RESPIRATORY SOUNDS 

The simulator is generates anterior, left and 
right lung sounds. Use the software controls to 
select between the available respiratory 
sounds and to adjust the volume of each lung 
independently. The respiratory sounds include 
normal, wheezing, inspiratory squeaks, 
crackles, and rales. 

VENTILATION 

Set the respiratory rate to 0 and ventilate the 
simulator using a standard bag valve mask. 
Open the CPR window to monitor the 
provider’s ventilation performance in real time. 
Complete the ventilation calibration process 
before using the ventilation feature for the first 
time. 

 

VENTILATION CALIBRATION 

The ventilation calibration wizard records the 
performance average of five ventilations as the 
benchmark for correct ventilation. Perform the 
actions requested by the calibration wizard 
following the most current CPR guidelines. 
The CPR window evaluates provider 
performance based on the benchmark 
recorded during the calibration process. 

To calibrate the ventilation performance 
benchmark: 

 Click Setup > Calibration > Ventilations, 1.
and click “Next” 

The wizard prompts to perform ventilation “#1” 

 Perform the first ventilation. A green filled 2.
oval indicates that the ventilation was 
recorded successfully 

 Perform ventilation # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the ventilation was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five ventilations 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 
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Cardiac 

HEART SOUNDS 

HAL generates audible heart sounds (normal, 
distant, systolic murmur, S3 and S4) tied to the 
heart rate and selectable rhythms. Use the 
software controls to change the heart sound 
type and volume level. 

ECG MONITORING AND 
ELECTRICAL THERAPY 

The simulator is equipped with conductive skin 
sites that allow the attachment of real 
electrodes and defibrillator pads. This feature 
allows the provider to track cardiac rhythms 
using real medical equipment just like with a 
human patient.  

The simulator’s ECG and defibrillation sites 
generate waveforms detectable using real 
medical equipment and standard electrodes. 
Real automated external defibrillators can 
detect the simulator’s heart rhythm and treat 
shockable rhythms.  

Defibrillation, pacing, and cardioversion is 
supported only on the large sternum and 
apex sites circled RED. Do not deliver a 
shock to ECG electrode sites on the 
shoulders or waist marked GREEN. The 
warranty does not cover damaged to the 
simulator caused by applying an electrical 
charge to the ECG sites. 

For exercises that incorporate real 
electrical therapy of any kind, always follow 
the safety guidelines and operating 
procedures outlined in the medical device 
manufacturer documentation. 

 

ECG AND DEFIBRILLATION 
WARNINGS 

 Always follow the standard medical 
guidelines and precautions for handling 
electrical therapy devices. Improper use of 
a real electrical therapy device may result 
in personal injury. 

 Operate simulator in a well-ventilated area 
free of flammable gases. 

 Ensure the simulator is fully assembled, 
fully operational, dry, and undamaged 
before administering electrical therapy. 
Never apply electrical therapy if the 
simulator is in contact with a conductive 
surface or substance. 

 Do not leave electrodes or pads attached 
to the conductive sites when the simulator 
is not in use. 

 Use hard paddles or wet-gel pads 
preferably. Avoid using solid-gel pads as 
they increase the risk of burning the 
simulator’s skin if arcing occurs. When 
using gel patches, make sure not to leave 
air gaps or bubbles between the pads and 
the conductive area on the simulator’s 
skin to avoid arcing. 

 Clean the conductive sites at the end of 
the simulation. Refer to the care section 
for more information on approved cleaning 
products. Gel residue, adhesive residue, 
or dirt can increase the risk of arcing 
during defibrillation. 

 Do not reused gel-adhesive or use 
expired pads. 

 Do not attempt to repair or modify any 
electrical connections or conductive sites. 
Discontinue use if wires are exposed, wire 
insulation is damaged, or if any 
conductive sites are damaged. 

 Electrode gel can become a pathway for 
electrical current. Do not allow 
defibrillation pads to overlap ECG sites or 
gel to carry a current to the ECG sites. 
Applying an electrical current to the ECG 
sites will result in damage to the 
simulator’s internal components. 

 Some electrical therapy devices may be 
sensitive enough to detect the simulator’s 
electrical current for operation. If the 
interference is displayed on the ECG 
reading, please disconnect simulator’s 
charger and operate the simulator on 
battery power only. 
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CHEST COMPRESSIONS 

Set the heart rhythm to asystole and instruct 
the provider to perform chest compressions. 
Monitor the depth and frequency of chest 
compressions from the CPR trainer window. 
Before using the chest compression feature for 
the first time, please calibrate the chest 
compression feature.  

 

COMPRESSION CALIBRATION 

The compression calibration wizard records 
the performance average of five compressions 
as the benchmark for a correct compression. 
Perform the actions requested by the 
calibration wizard following the most current 
CPR guidelines. The CPR window evaluates 
provider performance based on the benchmark 
recorded during the calibration process. 

To calibrate the compression performance 
benchmark: 

 Click Setup > Calibration > Compressions, 1.
and click “Next” 

The wizard prompts to perform compression 
“#1” 

 Perform the first compression. A green 2.
filled oval indicates that the compression 
was recorded successfully 

 Perform compression # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the compression was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five compressions 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 
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Circulation 

BILATERAL PULSES 

The simulator’s palpable pulses are blood 
pressure dependent. Use the software controls 
to disable the radial pulses to simulate severe 
hypotension. 

IV ARM 

The simulator is equipped with an IV arm that 
allows for bolus or intravenous infusions as 
well as for drawing fluids. 

WARNING 

Do not attempt to fill IV system without the 
drain connector in place. Always leave the 
drain port connected when injecting fluids 
into the system. 

Use only Gaumard’s artificial blood 
concentrate or clean water to fill the 
vasculature. Any other simulated blood 
brand containing sugar or any additive may 
cause blockage and/or interruption of the 
vasculature system. 

Always flush the IV system with distilled 
water at the end of every simulation. 

INSTRUCTIONS FOR USE (HAL 5 
YEAR) 

To prime the IV arm for an infusion exercise or 
to draw fluids: 

 Locate the fill syringe with tubing and the 1.
drain tube with pinch-clamp. Fill the 
syringe with the desired fluid -- water or 
simulated blood. 

 

 Connect the syringe with tubing to one 2.
port and the drain tube with clamp to the 
other port as shown. 

 

 Insert water in the system until fluids exits 3.
through the drainage tube into the 
container and all air bubbles are purged. 

 

The IV arm is now ready for use. 

To simulate a patient with no accessible 
peripheral IV sites, connect only the syringe. 
Pull the plunger to create suction, which will 
collapse the veins. Disconnect the syringe 
tube from the arm port while maintaining 
suction. The port will seal, and the veins will 
remain collapsed. 

INSTRUCTIONS FOR USE (HAL 1 
YEAR) 

To prime the IV arm for an infusion exercise or 
to draw fluids: 

 Locate the fill syringe kit and port 1.
adapters. Fill the syringe with water or 
simulated blood. 

 Using the kit adapters, connect the 2.
syringe and drain tube to the vein ports 
located on the forearm. 

 Push fluid into the vein port until it exits 3.
through the drain tube. 

 Disconnect the fill syringe and drain tube. 4.

The IV arm is now ready for use. 
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To simulate a patient with no accessible 
peripheral IV sites, connect only the syringe. 
Pull the plunger to create suction, which will 
collapse the veins. Disconnect the syringe 
tube from the arm port while maintaining 
suction. The port will seal, and the veins will 
remain collapsed. 

CLEANING THE VEINS 

Clean and dry the forearm vasculature at the 
end of the simulation session to prevent mold 
or clogs. 

To clean and dry the IV arm: 

 Fill the filling syringe with distilled water 1.

 Connect the fill syringe and the drain tube 2.
to arm 

 Flush the vasculature with distilled water. 3.
If the IV arm is not going to be used for a 
week or more, purge the system with 70% 
isopropyl alcohol solution. 

 Fill the filling syringe with air and purge 4.
the clean water to dry the vasculature. 

 Disconnect the drain tube and filling 5.
syringe 

Warning: Do not store the simulator with 
fluids in the veins. Doing so may lead to 
molding and damage to the internal 
electronics. Complete the vasculature 
cleaning procedure at the end of the 
simulation sessions. 

BLOOD PRESSURE PORT 

Connect the modified blood pressure line to 
the port on the simulator’s left shoulder. Before 
using the blood pressure feature for the first 
time, place the blood pressure cuff on the arm 
and calibrate the blood pressure feature using 
the blood pressure calibration wizard. 

 

BLOOD PRESSURE CALIBRATION 
WIZARD 

Before starting the calibration process, place 
the blood pressure cuff on the simulator as it 
would be placed on a real human patient. 

To calibrate the blood pressure feature: 

1. Click Setup>Calibration>Blood pressure 
and click “Next” 

2. Set the pressure on the BP cuff to 0 (i.e. 
cuff valve open) as prompted by the 
calibration wizard. 

3. Click the “OK” button to record the current 
cuff pressure for the interval. A green filled 
oval indicates the pressure interval was 
recorded successfully.  

4. Set the pressure on the BP cuff to 20 
mmHg as prompted by the wizard and 
then Click “OK” to record. 

5. Continue increasing the BP cuff pressure 
as indicated by the prompt and recording 
the pressure intervals. 

At the end of the calibration wizard, click 
“Finish” to close the calibration wizard. 

CENTRAL CYANOSIS 

Use the software controls to adjust the 
cyanosis intensity.  
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Neurological 

REACTIVE EYES 

The simulator is equipped with programmable 
blinking eyes and pupils that dilate. Use the 
software controls to change the blinking rate 
and to enable or disable pupil reaction. 

 

PUPIL CALIBRATION 

The eye reaction is factory calibrated. Use the 
“Pupil Sensitivity” controls to recalibrate the 
pupil reaction for the current room lighting only 
if needed. 

To calibrate the pupil dilation: 

1. From the File menu, go to 
Setup>Options>Tolerances 

2. Click “Set ambient light” to recalibrate the 
pupil diameter to the current ambient light. 

3. Cover both eyes from most incoming light 
and click "Set Dilation Light" to set the low 
light pupil diameter. 

4. Click increase or decrease to adjust the 
pupil’s sensitivity to light 

SEIZURES 

The simulator is capable of convulsing to 
simulate mild or severe seizures. Use the 
software controls to enable the seizure 
behavior. 
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Other 

URINARY CATHETERIZATION 

HAL features an internal bladder for 
catheterization exercises.  

Simulator 
Model 

Maximum 
Infusion 
Volume (mL) 

Catheter 
size 

S3004  
HAL 1 year 

48 8 Fr 

S3005 
HAL 5 year 

90 10 Fr 

To fill the bladder with fluid to perform a 
catheterization exercise: 

1. Place the simulator face down and locate 
the bladder fill port. 

 

2. Fill the kit syringe with water. 

3. Connect the fill kit syringe to the bladder 
fill port.  

4. Inject fluid into the bladder. Do not exceed 
the maximum infusion volume. 

INSTRUCTIONS FOR USE 

Catheterize the simulator using the 
appropriately sized catheter lubricated with 
silicone oil. At the end of the exercise, drain 
the fluid from the bladder reservoir to prevent 
mold. 

 

RESUSCITATION (CPR) 

The simulator features ventilation and 
compression sensors for monitoring CPR 
performance. The CPR window detects 
ventilations when the respiratory rate is set to 
zero or apneic and compressions when the 
heart rhythm is in an unhealthy state.  

Complete the ventilation and compression 
calibration process before using the CPR 
window for the first time.  

INTRAMUSCULAR INJECTION 
SITES 

Intramuscular injection sites are located on 
both deltoids and quadriceps for injection 
technique and placement exercises. 

GASTRIC DISTENSION 

HAL can exhibit gastric distension if ventilated 
excessively. To relieve the gastric distension, 
press down on the stomach gently. 

STREAMING AUDIO 

Use the streaming voice to speak as the 
simulator’s voice and engage the provider in a 
realistic conversation.  

INSTRUCTIONS FOR USE 

Ensure that the headset and microphone is 
connected to the PC before starting the GIGA 
software. The headset minimizes echo and 
environmental noise to improve audio quality. 
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Click the “talk” icon and speak in to the 
headset to talk as the simulator’s voice. 

 

To listen to the provider’s response, click 
“Listen”. 

 

Reference the GIGA software User Guide for 
information on additional streaming voice 
features and functions. 

INTRAOSSEOUS ACCESS 

HAL features replaceable tibia bones on the 
left leg for intraosseous access. The hollow 
bones allow for the aspiration and infusion of 
fluid using real medical devices.  

To fill the tibia bones with fluid: 

1. Remove the skin cover from the right leg. 

 

2. Remove the tibia insert. 

 

3. Remove the bone’s reservoir cap and use 
the fill kit syringe to fill the bone reservoir 
with fluid. 

4. Replace tibia bone in the leg and the skin 
cover. 

INSTRUCTIONS FOR  USE 

Intraosseous access is only supported on the 
hollow tibia insert. To view a list of 
replacement parts including leg skin covers 
and tibia bones, go to page 168. 
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Appendix 
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Scenario Frequently Asked Questions 
(FAQs) 
THINKING IN TERMS OF PALETTE ITEMS 

As described previously, Palette items represent complete or partial groups of settings that have 
been stored as a single item. We learned how applying partial states will hold constant all settings 
that are left unspecified. 

Not only does it take time to customize the palette, but a very large palette becomes difficult to 
navigate. So, it is desirable to minimize the number of Palette Items in each Profile. To accomplish 
this, an experienced facilitator tries to create items that are as generally applicable as possible and 
can, thus, be applied to a wide range of scenarios. The key is to only include in your Palette Items 
the settings that are directly related to the physiological event represented by that Palette Item. 

SMART SCENARIOS 

After reading the Details, Palette, and Scenarios sections of this guide, it should be clear how to 
build a scenario. You may have already tried building your own or modifying some of the factory 
presets. The following four guidelines will refine your ability to build the best possible scenarios. 

1. How will the scenario begin? 

The first thing to consider is the initial condition of the patient. Create a Palette Item to describe this 
condition. Make sure that this first step in the scenario is a complete state. That is, indicate some 
selection for each and every available setting on the Details page. Remember that only the settings 
you specify will cause a change in HAL®, and all other settings will remain constant. So, by starting 
with a complete state, HAL®'s condition will always be the same when the scenario starts, 
regardless of what he was doing previously. 

Likewise, the "transition duration" of the first step in the scenario should be zero, indicating that 
changes are applied immediately. 

There is one point that can cause confusion and warrants further explanation. It is an extension of 
the above discussion of partial states. The issue is best illustrated through the following example: 

Suppose that you are creating a Palette Item to start your scenario. In this case, you have decided 
that the patient will be apneic. The question is, "How should the lung sounds be set?" 

Most people's first inclination is to set the lung sounds to "none." This is incorrect, despite apnea. 
Obviously, no lung sounds should be heard during apnea, but since you have already set 
respiratory rate to zero, none will be. (Sounds are synchronized to the breathing cycle.) 

What you are really setting here when you choose a lung sound is the condition of the lungs, given 
respiratory drive. That is, if the patient's respiratory rate were changed from zero, what sound 
would be heard? Assuming that the lungs themselves are normal in this scenario, you would 
choose "normal" for the lung sound setting. 

Then, as the scenario progresses, if the patient starts breathing, there will be no need to set the 
lung sound again. It will already be set. The same principle applies to the heart sound and other 
settings. 

2. Include notes to guide the facilitator during the simulation. 

It is common for scenario designers, especially those who act as facilitators, to neglect the 
importance of notes in the scenario. They think that they will remember the learning objectives, 
patient history, and other details at the time they are ready to conduct the simulation.  hey usually 
don't, especially when revisiting a scenario months after creating it. 

When you add "Wait" and "Wait Indefinitely" steps to a scenario, you have an opportunity to edit 
the item description. Use this description field to hold notes to the facilitator. Typically, scenario 
designers write notes in that space to indicate what the provider(s) or facilitator should be doing at 
that point. 

Further, when saving the scenario, you may edit the scenario description. This is the best place to 
put patient history and any other longer notes and instructions. 
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3. Assume that providers will do the right thing.  

Usually, you should create a scenario with the assumption that the providers will perform correctly. 
As long as they do, the scenario can simply be allowed to continue. 

Naturally, you must be prepared for what might happen to HAL® when providers deviate from 
expectations. The consequences of such deviations can sometimes be included in the scenario, 
punctuated by "Wait Indefinitely" items. In other cases, the simulation will require more direct 
control by the facilitator via either the Palette or Details page.  

4. Choose auto-response settings based on the scenario content and the objectives. 

As you've seen, auto-responses can be used to free the facilitators attention. They also enhance 
realism by presenting instant reactions to the care providers. On the other hand, sometimes it is not 
possible or desirable to determine the responses before the simulation begins. Different 
environments and applications call for different settings. 

Some teaching practices are best done with the auto-response settings in Prompt mode. 
Responses must be triggered by a vigilant facilitator. Though it is slower and requires more 
attention, the benefit of Prompt over other modes is that the simulation can be allowed to go in any 
direction, and it will be possible to choose the response on a case-by-case basis. 

Other learning exercises require a higher degree of automation. For such applications, most 
facilitators choose Auto mode for the auto-response settings. The key issue is standardized timing 
of symptom presentation. A consistent, repeatable simulation is essential for fair assessment of 
that care provider in relation to others and for the broader interpretation of results in the context of 
training validation studies. 

When in doubt, it is best to choose Prompt mode, in which the facilitator will be given direct control 
of the responses as events are detected. 
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Scenario Flow Charts 

PEDIATRIC HAL 5 YEAR SCENARIOS 

Category Scenario 

Respiratory 

 1. Asthma 

2. Foreign Body Aspiration 

3. Upper Airway Obstruction (Toy Balloon) 

4. Epiglottitis 

Trauma 

 1. Chest Injury 

2. Hypothermia 

3. Alcohol Ingestion  

4. Organophosphate Poisoning 

5. Renal Failure and Hyperkalemia 

Cardiac 

 1. Soccer boy with SVT 

2. Cardiac Arrest 

3. Cardiac Ischemia 

4. Cardiac Tamponade 

5. Supraventricular Tachycardia 

Systemic 

 1. Gram Negative Sepsis 

2. Status Epilepticus 

3. Fire Victim 

4. Septic Distributive Shock 

5. Diabetic Ketoacidosis 

Automatic 

 Adenosine OD 

Adenosine SD 

Adenosine UD 
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PEDIATRIC HAL 5 YEAR SCENARIO FLOW CHARTS 

HR: 150

BP: 120/80

RR: 40

O2: 88%

Lung sounds: Bilateral Wheezing

Temperature: 38.4 Deg C

Wait indefinitely for O2 and 

Albuterol

HR 150

RR: 35

O2: 92%

BP: 120/80

Lung sounds: Bilateral Wheezing

Temperature: 38.4 Deg C

Transition Time: 30 sec

End

Pediatric HAL
®
 Five Year - Respiratory Scenario

Asthma

A five year old, known asthmatic began coughing and wheezing the previous day.  His parents had 

“run out“ of his daily steroid inhaler two weeks ago.  He received two nebulized Albuterol the day 

before and slept through the night.  He had one treatment this morning but by mid morning he was in 

respiratory distress with audible wheezing and visible retractions.  He cannot speak in full sentences.

Appearance: Audible 

wheezing and visible 

retractions, “can’t breathe”

Administer O2 via face 

mask and give inhalation 

treatment with albuterol

O2 Sat 90%

Transition Time: 30 sec

Wait indefinitely for second 

inhalation treatment with albuterol 

and atrovent

Administer corticosteroids 

and transport to ED
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UA Sound: Biphasic stridor

Resp. Pattern: Apneustic

O2 Sat 88%

HR 120

BP 110/71

5 blinks/min

Wait indefinitely for intubation

UA Sound: Inspiratory Stridor

Left Lung Wheezing

Right Lung Disabled

O2 Sat 92%

HR 110

RR 30

BP 105/69

Transition Time: 1 min

End

Pediatric HAL
®
 Five Year - Respiratory Scenario

Foreign Body Aspiration

A five year old boy was visiting his grandmother who had a bowl full of peanuts on the table. He and 

his older brother were throwing the peanuts in each others mouths and laughing.  The five year old 

began choking and gasping for air.  He could still say a few words between coughing, but then he 

collapsed to the floor.  His grandmother ran into the room  and his older brother explained he had 

choked on a peanut.  His grandmother saw he was turning “blue”.   She told her grandson to call 

911.

Wait indefinitely for five 

abdominal thrusts

UA Sound: Inspiratory Stridor

Immediate Transition

The boy coughed and 

vomited saliva mixed with 

peanuts.

Rapid sequence intubation 

and ventilation expecting 

to push the foreign body 

into the right main 

bronchus and ventilate 

until bronchoscopy can 

extract the foreign body.

Administer pre operative 

steroids and broadspectrum 

antibiotics
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UA Sound: biphasic stridor

RR 62

O2 Sat 88% 

Inspiratory time: 60% 

HR 120

BP 111/73

Airway cleared 

successfully?

Increased cyanosis

Apnea

O2 Sat: -15%

HR: -30%

BP 99/68

Transition Time: 30 sec

Unsuccessful or

1 min timeout Yes

Holding state for 

secondary treatment 

options – No changes to 

vitals

Secondary 

Treatment 

Options

HR: +30%

BP: +15% Sys 

+10% Dias

Transition Time:  

1 min

O2 Sat +5%

Normal UA Sound

Transition Time: 

30 sec

O2 Sat 92%

Transition Time: 

15 sec

Racemic 

Epi

O2 delivery

IV or IO Epi

End

End

UA Sound: Inspiratory stridor

O2 Sat 94%

RR 25

Inspiratory Time: 30%

HR 105

BP 102/69

Transition Time: 1 min

Asystole

End

Tracheostomy

O2 Sat: -10%

NSR with Pause

HR 32

BP 30/20

Transition Time: 30 sec

Pediatric HAL
®
 Five Year - Respiratory Scenario 

Upper Airway Obstruction
“Toy Balloon 5yr”

You are at a birthday party where you see a five year old trying to blow up a balloon.  Instead of 

blowing out he sucks the balloon in and begins gasping for breath.  He is turning cyanotic and 

cannot cry. You assess his airway is obstructed and the obstruction must be removed. You try 

simple measures as back blows and chest thrusts and activate EMS.

Appearance: Cyanotic 

and unresponsive

“Can’t breathe“

Healthy Resting

Transition Time: 1 min

2 min timeout
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HR 140

BP 140/80

UA Sound: Biphasic stridor

Resp. Pattern: Apneustic

Right Lung Wheezing

Left Lung Normal

O2 Sat. 88%

Cyanotic

Temp. 40 Deg C

UA Sound: Normal

Resp. Pattern: Normal

O2 Sat 94%

RR 30

HR 130

BP 125/72

Temp. 42 Deg C

Transition Time: 30 sec

Yes UA Sound: None

Resp. Pattern: Apnea

Left Lung: No sound

Right Lung: No change

O2 Sat. 82%

BP 80/60

Temp. 42 Deg C

Transition Time: 1 min

No

Yes

Bradycardia

HR 55

Temp. 45 Deg C

Transition Time: 1 min

No

Asystole

Immediate Transition

End

IV, Antibiotics, 

Corticosteroids

HR 160

Temp. 45 Deg C

HR 100

BP 90/70

O2 Sat 98%

Transition Time: 1 min

No

Yes

Fluid bolus

Dopamine drip

Antibiotics

No

Yes

End

Pediatric HAL
®
 Five Year - Respiratory Scenario 

Epiglottitis

A five year old girl was recently adopted from another country.  Her immunization status is in 

question and her parents had planned to have her immunized soon.  Two weeks after her arrival in 

the United States she developed a high fever of 40 Deg C and has difficulty in swallowing.  Her voice 

became weak and she had coarse stridor with every breath.  Her parents tried treating her for croup 

with some cool mist as they had their other children but she showed no improvement.  Her parents 

then brought  her to the E.D.

Appearance: Anxious, 

sitting with her chin 

extended.

This five year old girl is in severe respiratory 

distress associated with high fever, stridor and 

hypoxia.  She is at risk for respiratory failure.  

Possible diagnosis include epiglottitis or 

bacterial tracheitis.  She is unlikely to have 

croup at age five and you remember many 

countries do not immunize for Haemophilus 

influenza type B, an important cause of 

epiglottitis and meningitis prior to the 1980’s in 

the United States.  Your suspicion for 

epiglottis is high  so you alert  the persons 

most skilled in intubation,  anesthesiologist or 

otolaryngologist.

Allow to remain upright in a 

position of comfort and do 

not agitate with procedures 

as this may cause complete 

obstruction.

Intubation or 

cryco

Intubation with 

O2
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Airway Sound: Normal

HR 123

BP 82/63

O2 Sat: 88%

Blink Rate: 15bpm

Right Lung Disabled

HR 50

BP 64/43

O2 Sat: 88%

Transition Time: 45 sec

HR 100

BP 101/58

O2 Sat: 92%

Right lung enabled

Transition Time: 1 min

No Yes

Asystole

Immediate Transition

End

End

2 min timeout

Pediatric HAL
®
 Five Year - Trauma Scenario

Chest Injury

A five-year-old boy was racing his BMX bike over a dirt hill in his back yard.  He had his helmet on 

but not his chest protector.  His mother was watching and said he became airborne and the handle 

bar of the bike landed on his chest when he hit the ground.  He is crying, “my chest hurts” and “I 

can’t breathe”.  He was not unconscious and his extremities and abdomen appear normal.  You 

suspect fractured ribs, a lung contusion or a tension pneumothorax.

Appearance:

Alert and crying Perform immediate needle 

decompression by inserting an 

over the needle twenty gauge 

catheter other the top of the 

child’s third rib in the mid 

clavicular line.  After a gush of 

air, connect to a stopcock.

Patient stable 

for transport

Appearance: Altered 

consciousness

Wait 20 seconds for CPR

Same vitals

Transition Time: 10 sec

Wait 30 seconds for Epi 

via ET Tube and 

continue CPR

Decompression 

performed 

successfully
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HR 60

RR 20

BP 59/30

Temp 28 Deg C

O2 Sat 75% 

Sinus Bradycardia 

Lung Sounds – Bilateral Rales

RR 10

V-Fib

Transition Time: 20 sec

Normal color

HR 80 

BP 85/62

RR 30

Pulses present

O2 Sat 92%

Transition Time: 45 sec

BothExternal only

Asystole

Immediate Transition

EndEnd

2 min time out

Pediatric HAL
®
 Five Year - Trauma Scenario 

Hypothermia

A five year old boy wandered away from his parent’s farm house in freezing temperatures. He was 

found by a passing motorist curled in a snow drift.  He was dressed only in pajamas and his 

exposure time was at least four hours.  The motorist wrapped him up and drove him to the hospital.

Appearance:

Blue with frozen finger tips, 

responds only to deep pain

Assessment: Patient is 

bradycardic, hypotensive 

and hypothermic but 

does not require CPR as 

oxygen requirements are 

lower at lower 

temperatures.  

Treat patient with both external 

and internal warming.  This 

includes a heating blanket, 

warmed IV fluids, warmed O2, 

warmed gastric lavage, and 

warmed peritoneal lavage.

Appearance: Normal 

color, responds to voice

Continued treatment 

would include treating 

pulmonary edema, 

pneumonia an to begin 

agitated hot water baths 

for the frostbitten fingers

Rapid external warming 

without internal warming 

causes hypovolemic 

“rewarming shock”.  Cold 

IV fluids further depress 

the heart rate.

Patient does 

not respond to 

cardioversion 

and expires

Begin CPR and 

follow pulseless 

arrest algorithm

External and 

internal warming
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HR 50

BP 80/45

RR 15

Temp 36.1 Deg C 

O2 Sat 90%

HR 80

BP 90/60

RR 25

Temp 36.6 Deg C

O2 Sat 96%

Transition Time: 1 min

Cough

HR 60

BP 85/50

RR 0

O2 Sat 85%

Transition Time: 20 sec

HR 80

BP 100/60

RR 18

O2 Sat 96%

Seizures

Transition Time: 30 sec

Intubation

Or

2 Min Timeout

Deliver O2

20cc/kg normal saline bolus

Bolus of D10W

Infusion of IV fluids with glucose

Deliver O2 and correct hypotension

End EndEnd

Pediatric HAL
®
 Five Year - Trauma Scenario

Alcohol Ingestion
Bradycardia and Hypoglycemia

A five year old boy wakes up early and is thirsty.  His parents had a party the night before and left 

glasses half full of mixed alcoholic drinks around the living room.  When the parents get up two hours 

later they find him asleep on the floor and smelling of alcohol.  They cannot wake him up so they call 

911.

Appearance: 

Unresponsive to 

name or pain

Correct Assessment: 

Bradycardia, and mild 

hypothermia without 

hypotention or 

respiratory depression

Transport 

to ED

Intubation causes 

vomiting and 

aspiration

Failure to treat 

hypoglycemia 

results in seizures.

Chin lift and deliver O2

Treat glucose deficiency 

and hypotension
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Pinpoint Pupils

BP 60/40

HR 70

RR 20

Rhythm: RBBB

Mild tremors

BP 70/50

HR 80

RR 25

Larger pupils

RBBB

Mild tremors

Transition Time: 45 sec

V-Fib

BP 0

RR 0

Immediate Transition

YES

NO

NO

NSR

BP 95/69

HR 90

RR 30

Normal pupils

Transition Time: 45 sec

YES

EndEnd

Pediatric HAL
®
 Five Year - Trauma Scenario

Organophosphate Poisoning
“OP Poisoning”

A five year old immigrant boy wandered in a field that was recently sprayed with pesticides 

(Organophosphate).  His parents took off his cloths and washed him off with water but a few minutes 

later he began vomiting and became "limp".  They drove him to the ED that was thirty minutes away.  

Appearance:

Pinpoint pupils, tearing, 

drooling, muscles twitching

Muscles still twitching

Do ABCs and wait 

“thirty minutes”

Excessive secretions 

make intubation and 

ventilation extremely 

difficult. Prolonged 

QT progresses to VF 

that doesn’t respond 

to antiarrhythmics.  

Patient expires.    

Twitching stops

Atropine 0.015 

mg/kg IV

Repeat Atropine at 

higher dose and add 

2PAM
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HR 100 

BP 120/70

RR 25

Temp 37.2 Deg C

O2 Sat 92%

Normal Pulses

ST Segment Elevation 

V-Tach

Transition Time: 30 sec

Healthy Pedi

Transition Time: 1 min
YesNo

V-Fib

RR 10

Transition Time: 30 sec

End End

Pediatric HAL
®
 Five Year - Trauma Scenario

Renal Failure and Hyperkalemia

A five year old boy presents to the ED with some tiny red dots on his arms and legs and his mother 

says he hasn’t “peed” since yesterday. Last week he had some bloody diarrhea and has been 

vomiting for two days but they were on vacation so they didn’t see a doctor.

Appearance: Alert, pale 

with numerous petechiae

Assessment: Airway and 

breathing are stable.  

Patient may be anemic and 

have low platelets.  That 

could account for the rash 

and pale appearance.  

Send labs and start IV to 

keep open.

Action: Note ST Segment 

elevation and treat for 

hyperkalemia.

Lab report confirms anemia, 

low platelets BUN of 60, and 

serum potassium of 6 mEq/L.  

Correctly diagnose Hemolytic 

Uremic Syndrome and refer to 

the Nephrologist for dialysis 

and further management.

Calcium 

Chloride IV 

20mg/kg
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SVT

HR: 200

BP: 60/40

O2: 92%

RR: 40

NSR

HR: 100

BP: 80/60

RR: 40

Transition Time: 1 min

Asystole lasting 2 seconds

End

Pediatric HAL
®
 Five Year - Cardiac Scenario 

Soccer Boy with SVT

A previously healthy boy is brought to the ED because his mother says he has been acting tired and 

passed out while playing soccer today. He said his chest hurts and his heart jumps.

Administer O2, adenosine 

rapid bolus IV, and perform 

vagal maneuvers

Adenosine given

V-Fib

Transition Time: 30 sec

Asystole

Immediate Transition

End

No adenosine
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Ventricular Fibrillation

RR:0

Eyes Closed

Wait indefinitely for 

additional shock

HR: 60

BP 59/0

RR 30 (BVM)

Transition Time: 1 min

Shock effective?No

NSR

HR: 100

BP:80/60

RR:30

O2: 95%

Blinking 15 bpm

Transition Time: 1 min

Yes

End

Pediatric HAL
®
 Five Year - Cardiac Scenario

Cardiac Arrest

While watching a baseball game a five-year-old boy was hit by a high velocity “foul ball” in the chest.  

He immediately falls to the ground and cries “I’m hurt”.  As you approach he becomes unresponsive. 

You access the ABC’s and find him to be pulse less and not breathing.  You call for an EMT and 

report a cardiac arrest.

End

Appearance:

Unresponsive Begin CPR with BLS

AED is applied to check 

rhythm and a shockable 

rhythm is present.  Give one 

shock @ 2 J/kg,  resume 

CPR and recheck rhythm.  

Insert ET tube

Still unresponsive and in 

cardiac arrest.  Administer 

a second shock @ 4 J/kg, 

continue CPR and 

recheck rhythm.

Wait indefinitely for Epi 

via ET Tube

HR 80

RR 30

BP 80/60

Pulses present

Transition Time: 30 sec

Begin post 

resuscitation care
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ST Segment Elevation

HR 150

RR 30

   BP 120/70 

Temp 37.5 Deg C

 O2 Sat: 99%

Healthy Vitals

Transition Time: 1 min

Yes

HR 60

   BP 140/90

Cheyne-Stokes

Seizures

Eyes closed

Pupils unresponsive

Transition Time: 45 sec

No

End

End

Pediatric HAL
®
 Five Year - Cardiac Scenario

Cardiac Ischemia 
Carbon Monoxide Poisoning

During the ride home from a family camping trip a five year old boy falls asleep in the back of his 

parents truck camper. The night was cold so the heater in the cab was turned on. When they 

returned home he seemed confused, couldn't walk and complained of a headache and vomited. His 

parents bring him to the ED and are worried about meningitis .

Appearance:

Lethargic but responsive, 

gait unstable

Assume vitals are related to a 

“flu-like” illness.  Perform a 

physical exam and send CBC 

and Strept test to the laboratory.  

Send the boy for a chest X-Ray.  

Thirty minutes later the has a 

seizure and is now comatose 

from cerebral edema.

COHb has decreased to 20%.  

Cardiac troponin is elevated.  

Support the ABCs and arrange 

for transport to a hyperbaric 

chamber.  The hyperbaric 

chamber can displace the 

carbon monoxide faster than the 

oxygen given at atmospheric 

pressure and better protect the 

brain and heart from further 

hypoxic damage.   

Assessment: Suspect Carbon 

Monoxide poisoning with cardiac 

ischemia.  Check for exhaled 

carbon monoxide concentration 

with micro COHb meter.  COHb 

is elevated at 25%.  Send blood 

for cardiac troponin   

Wait “15 minutes”

100% O2 delivered via 

non rebreather mask
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HR 99

All pulses absent

RR 0

   BP 0

Eyes closed

End

NSR

HR 91 

O2 Sat 97%

BP 93/71 

Transition Time: 30 sec

Wait indefinitely for: 

Intubation

Oxygen

Epinephrine

HR 105

BP 0

All pulses absent

RR 30 (Ventilations)

Eyes Closed

Transition Time: 5 sec

Wait indefinitely for:

Pericardiocentisis

Pediatric HAL
®
 Five Year - Cardiac Scenario 

Cardiac Tamponade
Obstructive Shock / Pulseless Arrest

A five year old boy has a gunshot wound to his chest.  The family has called 911 but has not begun 

CPR .You are the first responder with your emergency team. The boy is unresponsive with an entry 

wound near his heart. The family said he was crying a few minutes ago.

HR 55 

BP 62/43

O2 Sat 94%

Transition Time: 30 sec

Wait indefinitely for:

Fluids

Vasopressors

Appearance: 

Unresponsive

Not breathing

Cyanotic Assess that the airway is patent.  

Intubate the boy and begin 

ventilation with 100% O2.  He has 

no pulse.  Begin CPR, attach a 

monitor/defibrillator, start an IO and 

give an epinephrine rapid rush.  

Equal breath sounds are detected 

with ventilation.  The cardiac 

monitor shows PEA.  Radio the 

base and describe the possibility of 

cardiac tamponade and request 

permission for an emergency 

pericardiocentisis.  The base 

control says to try another dose of 

epinephrine, continue CPR and 

recheck the rhythm. 

Base control grants permission to 

perform emergency 

pericardiocentisis and aspirate 

bloody pericardial fluids.

Begin post resuscitation care with 

fluids and vasoactive agents.  
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Initial Observations

Color: Pink

HR: 230

RR: 40

O2 Sat: 94%

Speech: Heart beats

Speech: Feel sick

O2 Sat: 96%

Transition Time: 1 min

O2 Sat: 89%

Transition Time: 1 min

O2 Sat: 89%

Speech: Ouch!

Transition Time: 45 sec

Holding state for initial 

treatment options – No 

changes to vitals

Speech: Heart Jumping

RR: 60

O2 Sat: 86%

Speech: Dizzy

Immediate Transition

Apneustic

Transition Time: 30 sec

No 

(2 minute timeout)

2 sec Asystole followed 

by a 2 min transition to 

Healthy Vitals

Initial treatment 

options

O2 Delivered

Cannula

Action taken

2 adenosine doses

Healthy vitals

Transition Time: 2 min

Yes

Healthy vitals

Transition Time: 2 min

Cardioversion

Asystole

Immediate Transition

None (2 minute timeout)

BVM

Intubation

Cardioversion

End End

End End

Valsalva

Pediatric HAL
®
 Five Year - Cardiac Scenario

Supraventricular Tachycardia 

A previously healthy boy is brought to the ED.  According to his dad he has been acting tired and 

passed out today. He said he feels dizzy and his heart jumps.

GSC < 8
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HR 180

RR 30

BP 90/60

Temp 38.3 Deg C

Sinus Tachycardia

RR 40

BP 78/50

Transition Time: 1 min

HR 140

RR 30

BP 90/60

Temp 37.2 Deg C

Transition Time: 1 min

IV Fluids only Fluids and Antibiotics

Wait 45 seconds for IV 

fluids

HR 60 

RR 0

BP 50/0

Absent pulses

Transition Time: 30 sec

Asystole

End

End

Pediatric HAL
®
 Five Year - Systemic Scenario

Gram Negative Sepsis
Perforated Viscous and Peritonitis

A five year old boy, with cerebral palsy is carried in to the ED by his foster father. He is one of five 

foster children, all with special needs.  He wears braces to walk and has speech and language 

delays.  He has been vomiting for three days and has been refusing to eat. He has also been crying 

a lot. He has no medications.  His foster father says he has to leave because his wife needs the car 

to go to work.

Appearance: Small thin 

boy curled in fetal position, 

moaning in pain.  His 

clothes smell of vomitus Perform complete and accurate physical 

exam that reveals absent bowl sounds 

and tense and tender abdomen.  

Differential diagnosis would include 

“Ruptured Appendix”.

Order CBC, CRP, blood cultures and 

begin patient on antibiotics with gram 

negative coverage after a bolus of IV 

fluids.  CT Scan of the abdomen shows 

an abscess in the lower quadrant 

consistent with a perforated appendix.  

Obtain surgical consult

The patient is uncooperative 

and irritable.  Perform cursory 

exam and Diagnose Acute 

Gastroenteritis.  Place patient 

on IV fluids, send labs and 

obtain stool culture.  

Despite high quality 

CPR, the patient dies.  

Postmortem shows 

peritonitis with multiple 

abscesses and a 

perforated appendix.

Patient is stable 

for surgery

Perform Action
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RR:5

O2: 90%

HR: 140

BP:90/60

Eyes Closed

Seizures

Cyanotic

RR: 0

No Seizures

Transition Time: 1 min

RR: 30 (ventilator)

O2 Sat 92%

Seizures

Immediate Transition

Wait indefinitely 

For BVM

Convulsions stop

HR 110

O2 Sat 94%

Transition Time: 1 min

Wait indefinitely 

for Lorazepam 

and Phenytoin

Valium delivered over “5 

minute” followed by saline 

IV

No

RR:25

O2: 95%

HR: 90

BP:100/60

Blinking 15 bpm

Transition Time: 1 min

Yes

End

Pediatric HAL
®
 Five Year - Systemic Scenario

Status Epilepticus

Mom calls 911 because as her son was falling asleep she noticed seizure activity of his arms and 

legs.  He had had short seizures with high fever when he was one and two.  This Time he had no 

fever and was well the entire day. There has been no history of trauma.  He has been seizing for at 

least fifteen minutes.

End

Appearance: 

Non-responsive, cyanotic, 

eyes back in head, teeth 

clenched

Oerform BVM at a rate of 20 

through the nasal pharyngeal 

airway and prepare for endo 

tracheal intubation.  Choose a 

5.5 cuffed endotracheal tube 

and place him on a ventilator.   
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ST Segment Elevation

HR 130

RR 40

   BP 70/40 

Temp 37.2 Deg C

 O2 Sat: 90%

Speech: Cough

Speech: Head hurts

Wait indefinitely for intubation, IV 

access and bolus of normal saline at 

20 cc/kg

NSR

HR 110

RR 32

   BP 80/60 

 O2 Sat: 94%

Transition Time: 30 sec

Wait indefinitely for second bolus of 

saline

BP 90/60 

Transition Time: 30 sec

End

Pediatric HAL
®
 Five Year - Systemic Scenario

Fire Victim

A five-year old boy is rescued by his father from a house fire. He was found in his bedroom asleep. 

The room was engulfed with flames and smoke. His pajamas are charred and his face is burned and 

covered with soot.  His pajamas are removed to reveal his arm and torso are burned.  He inhaled a 

large amount of smoke during the fire.

Appearance: hoarse cry 

with visible burns of the 

face and chest

Access unstable airway 

and deliver high flow O2. 

Obtain IV access with two 

large bore needles

Map Burn: Calculate body 

surface area.  Over 12% so 

perform fluid resuscitation 

according to Parkland added 

to regular maintenance and 

transfer to burn center. 

Burns are a common cause of injury 

world wide.  Flame burns are the 

most common.  Victims of serious 

flame burns are also at high risk of 

inhalation injury of the airway and 

lung tissue.  These children should 

receive early airway intervention as 

swelling increases with time and 

makes intubation extremely difficult. 

Fluid resuscitation should be 

correctly calculated and recorded.  

All closed space burn patients 

should be checked for carbon 

monoxide poisoning.  
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HR 150

RR 40

   BP 70/50

 O2 Sat: 90%

Temp: 40 Deg C

Eyes closed

End

Wait indefinitely for actions 

to be performed

 O2 Sat: 92%

Temp. 39 Deg C

Transition Time: 1 min

HR: 140

RR: 30

BP: 90/70

Transition Time: 1 min

HR: 120

RR: 30

BP: 100/60

Transition Time: 1 min

Wait indefinitely for two 

boluses of isotonic fluid

Wait indefinitely for 

dopamine or dobutamine 

drip and stress dose 

hydrocortisone

Pediatric HAL
®
 Five Year - Systemic Scenario

Septic Distributive Shock

A five year old boy with Sickle Cell Anemia is brought to the ED with what the mother thought  were 

infected mosquito bites.  She treated them with antibiotic ointment.  Most of them improved except 

for one large area on his abdomen that now measures 3X4 cm. with a localized abscess formation.  

He developed fever yesterday of 40 Deg C.  Today he has developed chills and his temperature is 

still 40 Deg C despite fever reducers. He takes folic acid and penicillin daily.  His immunizations are 

up to date.

Appearance:

Anxious

Pale

Mild tachypnea

Assessment:  Increased heart 

rate, increased respiratory rate, 

hypertensive, hypoxic, and 

hypoglycemic.  These abnormal 

vital signs along with the skin 

lesions signal more than the onset 

of a systemic response to 

infection.  The skin lesions may 

contain methycillin resistant 

staphylococcus.   

Actions: Give Oxygen, antipyretic, 

obtain IV access, portable chest 

X-Ray, give 20 20 cc/kg of 

isotonic fluid bolus.  Wait 15 

minutes and administer first dose 

of antibiotics STAT   

Assessment: moderate 

response to fluid resuscitation, 

still poor perfusion with 

normalizing BP.  Chest X-Ray 

shows a Right Lower Lobe 

Consolidation   

This exercise emphasizes the 

continual need for fluid resuscitation 

in shock to improve preload but with 

attention to treating the cause with 

antibiotics and correcting 

hypoglycemia.  Poor perfusion 

despite fluid resuscitation often 

requires a vasoactive agent such as 

dopamine or dobutamine.  Different 

vasoactive agents are chosen 

depending on the response of blood 

pressure and tissue perfusion. 

After the second bolus 

the vitals do not 

change, therefore a 

third bolus is required.

Improve with 

vasoactive drip
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HR 140

RR 40

   BP 90/60

Temp 38.3 Deg C

 O2 Sat: 94%

Blinking: 5 Bpm

Biphasic T wave

HR 100 

RR 30

BP 90/60 

Transition Time: 30 sec

HR 70

BP 140/70

Cheyne-Stokes

Pupils constricted

Transition Time: 30 sec

End

NSR

HR 100 

RR 30

BP 90/60 

Transition Time: 

30 sec

Asystole

No
Yes

EndEnd

NSR

HR 100 

RR 30

BP 90/60 

Transition Time: 

30 sec

Asystole

No Yes

End

Excessive fluids

Pediatric HAL
®
 Five Year - Systemic Scenario

Diabetic Ketoacidosis

A five-year old boy presents to the ED with a history of vomiting for one day.  His mother says he 

has vomited at least ten times since the night before and he can’t keep anything down.  He has a 

low-grade fever and has not had diarrhea but he has been wetting the bed.  He appears pale with 

sunken eyes and breathing very rapidly.

Appearance: 

Lethargic and eyes 

blink to pain

Check Dextrostick 

(glucose 400) and start 

low dose insulin infusion. 

Begin hydration with 

normal saline.

Biphasic T 

wave indicates 

hypokalemia

No dextrostick checked.  

Blood chemistries sent to 

lab.  Patient given two 

boluses of normal saline 

over “30 minutes” and 

sent for X-ray.

Treat for cerebral 

edema with intubation 

and mannitol.Lab 

results come back 

(glucose 450).  Begin 

treatment with a low 

dose insulin infusion

Perform 

Actions

KCL IV
Perform 

actions
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PEDIATRIC HAL 1 YEAR SCENARIOS 

Category Scenario 

Respiratory 

 1. Bronchiolitis 

2. Upper Airway Obstruction (Toy Aspiration) 

3. Croup 

4. Pneumonia 

5. Pneumonia with Septic Shock 

Trauma 

 1. Shaken Baby Syndrome 

2. Drowning Boy 

Cardiac 

 1. Second Degree Block 

2. Sinus Tachycardia and Hypertension 

3. Congenital Heart Failure 

Systemic 

 1. Bee Sting 

2. Hypovolemic Shock 

Automatic 

 Adenosine OD 

Adenosine SD 

Adenosine UD 
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PEDIATRIC HAL 1 YEAR SCENARIO FLOW CHARTS 

HR 150

BP 100/60

Lungs Wheezing

RR 60

O2 Sat 88%

Wait indefinitely for 

suction of nasal 

secretions and 

supplemental O2

O2 Sat 92%

Transition Time: 30 sec

Both lungs normal

O2 Sat 94%

RR 40

HR 110

Transition Time: 1 min

End

Pediatric HAL
®
 One Year - Respiratory Scenario 

Bronchiolitis

A one year old child is brought to your ER with a one day history of a clear runny nose, low grade 

temperature and a wet cough. His mother states today that he is refusing to drink and appears to be  

breathing fast. She claims his immunizations are up to date and he has been in good health.

Appearance:

Cyanotic

Nebulized albuterol 

treatment successful?
Yes

RR 80

Wheezing

O2 Sat: 90%

Transition Time: 1 min

No

Baby appears tired

Wait indefinitely for racemic 

epinephrine via nebulizer 

every “four hours”

O2: 94%

RR 60

Transition Time: 1 min

Wait

“next day”

RR 80

O2 Sat 90%

Transition Time: 1 min

End

Chest X-Ray shows air 

trapping and atalectasis.  

Place on nasal C-pap 

and condition improves 

after 24 hours 

2 min timeout
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Airway: no sounds

Breathing: apnea

HR 90

BP 105/70

Blink: 15 bpm

Airway cleared 

successfully

Cyanosis Increases

HR +30%

O2 -15%

Eyes open

Transition Time: 30 sec

Healthy Resting

Transition Time: 1 min

Unsuccessful or

1 min timeout
Yes

Intubation 

performed 

successfully

Condition improves 

slightly

O2 +20%

R Lung Disabled

UA Sound: Stridor

Lung Sound: Wheezing

Transition Time: 45 sec

Airway cleared 

successfully
Yes Yes

NSR with pause

O2: -10%

HR 30

BP 30/20

Transition Time: 30 sec

Unsuccessful or

1 min timeout

V-Fib 

Transition Time: 30 sec 

30 second 

wait

Unsuccessful or

1 min timeout

End

End

Pediatric HAL
®
 One Year - Respiratory Scenario 

Upper Airway Obstruction
“Toy Aspiration”

You are at a birthday party where you see a one year old trying to blow up a balloon.  Instead of 

blowing out he sucks the balloon in and begins gasping for breath.  He is turning cyanotic and 

cannot cry. You assess his airway is obstructed and the obstruction must be removed. You try 

simple measures as back blows and chest thrusts and activate EMS.

Appearance: Cyanotic 

and unresponsive

Asystole

Immediate Transition

Due to intubation, the 

balloon gets pushed 

down into the right 

mainstem bronchus
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Airway Sound: Biphasic Stridor

RR 35

HR 140

BP 100/60

O2 Sat 94%

Temp. 38.1 Deg C

Wait indefinitely for racemic 

epinephrine via inhaled nebulizer 

and face mask over “10 minutes”

Airway Sound: Normal

RR 30

HR 160

BP 120/80

Transition Time: 1 min

Wait “15 minutes” for hospital 

transport

Real Time Wait: 2 min

Airway Sound: Biphasic Stridor

RR 40

HR 150

BP 110/80

O2 Sat 90%

Transition Time: 30 sec

Wait indefinitely for:

Racemic epinephrine

O2

Corticosteroid

Airway Sound: Normal

O2 Sat 95%

Transition Time: 30 sec

End

Pediatric HAL
®
 One Year - Respiratory Scenario

Croup

You are called to a home at two a.m. because a one-year old boy “can’t breathe”.  His parents said 

he was fine when they put him to bed. He has had no illness before and there is no history of 

asthma. He woke up with a “barking cough” and then began to struggle for each breath.  They called 

their advice line that said to put him in some steam from the bathroom shower.  He did not improve, 

so they called 911.

Appearance: Alert but fearful 

Has audible stridor and seal like 

“bark” with visible retractions

Assessment: Upper 

airway obstruction, most 

likely croup that requires 

immediate intervention.

Reassessment: The 

change in HR and BP is 

the adrenergic effect from 

the epinephrine.  The 

stridor has improved and 

he is not retracting.

Since the racemic Epi 

improved his upper airway 

obstruction, he must be 

observed for a rebound 

effect in the ED.     

Assessment: Stridor at rest, 

unable to speak with visible 

retractions. 

Assume the child has an upper air 

obstruction, now hypoxic, and will 

require repeat Racemic Epi and 

the addition of O2.  The upper 

airway edema may be decreased 

by giving a corticosteroid.  

Dexamethasone is a good choice 

because it can be given by IM.

After the second racemic 

epinephrine and again 

improvement of the stridor 

confirm the diagnosis of Croup 

with an X-ray of the lateral 

airway.  The X-ray demonstrates 

the classic steeple sign.

Wean patient 

from O2 after “12 

hours” and place 

him on a course 

of oral steroids.
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Cyanotic

Respiratory Pattern: Apneustic

Left Lung Sound: Rales

HR: 75

BP: 75/55

Temperature: 39.1 Deg C

O2: 84%

Wait indefinitely for O2 via nasal 

cannula

Repiratory Pattern: Apnea

O2: 80%

Transition Time: 10 sec

Wait indefinitely for BVM and 

prepare for endotracheal 

intubation

RR 30

O2: 92%

Transition Time: 30 sec

End

Pediatric HAL
®
 One Year - Respiratory Scenario 

Pneumonia

You are called to a home where a one-year old child is gasping forbreath. His mother says he has 

had wheezing before and is being treated for ”baby asthma”. He saw his doctor last week and has 

been receiving nebulized Albuterol three times a day for one week.  Over the past few days his fever 

has increased to 39.1 Deg C, his nose has become more filled with yellow mucous and he has had 

little to drink. He is not taking any antibiotics.

He appears tired and 

makes no eye contact 

with his mother.  

Airway open and dry.  

Irregular breathing with 

periods of apnea. This 

one year old is hypoxic 

with respiratory failure.  

After the nasal 

canula is placed, the 

respiratory pattern 

changes to Apnea  
Perform BVM ventilations 

at a rate of 30/minute with 

100% O2.  Check Braslow 

tape for correct ET tube 

size.  Perform the 

endotracheal intubation for 

no more than 15 seconds 

without returning to BVM. 

Place child on ventilator 

and administer a bolus of 

normal saline.
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Appearance: Cyanotic

Respiratory Pattern: Apneustic

Left Lung Sound: Rales

HR: 150

BP: 75/55

Temperature: 39 Deg C

O2: 84%

Respiratory Pattern: Apnea

O2: 80%

Transition Time: 10 sec

HR 150

RR 40

   BP 70/50

 O2 Sat: 92%

Temp: 40 Deg C

Eyes closed

Transition Time: 30 sec

End

 Temp. 39 Deg C

Transition Time: 30 sec

HR: 140

RR: 30

BP: 90/70

Transition Time: 30 sec

HR: 120

RR: 30

BP: 100/60

Transition Time: 30 sec

Wait indefinitely for O2 via nasal cannula

Wait indefinitely for intubation

Wait indefinitely for:

Antipyretic

Glucose

Calcium and electrolytes

Isotonic fluid bolus

Antibiotic stat

Wait indefinitely for bolus of isotonic fluid

Wait indefinitely for dopamine or dopbutamine drip

Pediatric HAL
®
 One Year - Respiratory Scenario

Pneumonia with Septic Shock

You are called to a home where a one-year-old child is gasping for breath. His mother says he has 

had wheezing before and is being treated for ”baby asthma”. He saw his doctor last week and has 

been receiving nebulized Albuterol three times a day for one week.  Over the past few days his fever 

has increased to 39 Deg C, his nose has become more filled with yellow mucous and he has had 

little to drink. He is not taking any antibiotics.

He appears tired and 

makes no eye contact 

with his mother.  

Airway open and dry.  

Irregular breathing with 

periods of apnea. This 

one year old is hypoxic 

with respiratory failure.  

After the nasal 

canula is placed, the 

respiratory pattern 

changes to Apnea  

Check Braslow tape for 

correct ET tube size.  

Perform the endotracheal 

intubation.

The sinus tachycardia is 

related to the Septic Shock.  

Obtain vascular access and 

administer fluids.
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HR 55

BP 140/90

Cheyne-Stokes  

Temp 36.1 Deg C

 O2 Sat: 95%

Eyes Closed

Healthy vitals

Transition Time: 30 sec

- Elevate head 30 degrees

- Intubation and IV access, draw appropriate labs

- Request emergency CT of the head and a 

neurosurgical consult

- IV fluids with normal saline and low dose mannitol to 

help reduce intracranial pressure.

Correct action

Asystole

Immediate Transition

Incorrect action

End End

Pediatric HAL
®
 One Year - Trauma Scenario 

Shaken Baby Syndrome

A young mother returned from her night shift to find her one year would not wake up when she went 

to check on him.  Her boyfriend said he was probably just sleepy because he had cried a lot the 

night before. She knows something is wrong and takes him to the ED.

Appearance: 

Lethargic and 

pale

Assessment: Bradycardia, 

hypertension, and abnormal 

respiration

CT Scan shows a large 

subdural hematoma that 

will require evacuation.

Fluid resuscitation and 

treating for sepsis.  Lumbar 

puncture could result in 

herniation of the brain and 

death.  Delay in treating 

increased intracranial 

pressure results in coma 

and brain death.
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Pediatric HAL
®
 One Year - Trauma Scenario 

Drowning Boy

A one year old boy falls into the pool and is found floating a couple of minutes later.  When the  

paramedics arrive the child is not breathing, has severe cyanosis and he is in asystole.  

Cyanotic

Eyes closed

RR 0

Asystole

Wait indefinitely for:

ABCs

CPR

Meds

RR 5

O2 Sat: 88%

NSR

HR 65

BP 60/40

Transition Time: 40 sec

Wait 20 seconds for:

Epinephrine

RR 25

O2 Sat: 95%

NSR

HR 105

BP 98/69

Eyes Blinking

Transition Time: 1 min

End
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Second degree AVB Type I

HR 100

RR 30

   BP 80/60 

Temp 37.2 Deg C

 O2 Sat: 95%

NSR

HR 100

   BP 50/30

Transition Time: 2 min

Wait indefinitely for 

pressor infusion to treat 

hypotension

HR 120

BP 73/58 

Transition Time: 3 min

Glucagon .05-.15mg/kg 

bolus followed by an 

infusion

Yes

NSR

HR 40

   BP 60/40

Transition Time: 2 min

Wait indefinitely for 

Atropine, IV fluids, 

pressors and high dose 

Epinephrine

HR 100

BP 80/60 

Transition Time: 3 min

No

End End

Pediatric HAL
®
 One Year - Cardiac Scenario

Second Degree Heart Block
Mobitz Type I (Wenkebach)

A one year old child was visiting his grandmother and was found playing in her purse.  She noticed 

her long acting propranolol bottle was opened and he may have ingested at least four pills about one 

hour ago.  She contacted poison control who told her to bring him to the hospital.

Appearance: Alert and 

active

ABCs may be stable initially 

because ingestion was of 

sustained release medication.  

A whole bowel irrigation is 

required with 30 cc/kg/hr of oral 

Golytely/hr until liquid stool.  

Obtain 12 lead EKG and begin 

IV fluids with normal saline.

12 lead EKG shows 

progressive lengthening of 

the PR interval until no QRS 

is conducted. This indicates 

a second degree heart block 

which is compatible with beta 

blocker toxicity and should 

be treated with Glucagon

Consider pacemaker for 

continued bradycardia
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NSR

HR: 200

RR: 40

   BP: 150/100 

O2 Sat: 94%

Temp: 40 Deg C

Pupils dilated

HR: 180

RR: 35

BP: 150/100

Temp: 38.9 Deg C

Transition Time: 1 min

HR: 140

RR: 30

BP: 140/90

Transition Time: 1 min

Yes

Cooling blanket,

fluids, or Diazepam

Temp: 41.1 Deg C

Seizures

Pupils unresponsive

Transition Time: 30 sec

No cooling blanket,

fluids, or Diazepam

Stroke

Eyes Closed

Pupils unresponsive

Immediate transition 

after 1 min wait.

No

BP 120/80

HR 140

RR 30

Pupils reactive and 

blinking

Transition Time: 1 min

End

End

End

Pediatric HAL
®
 One Year - Cardiac Scenario

Sinus Tachycardia and Hypertension
Methamphetamine Ingestion

A young mother brings her baby to the ED. She says her baby was crawling on the floor and put 

something in his mouth and swallowed it about an hour ago.  You notice the mother is thin, jittery 

with open sores on her face and arms.  You consider the ingestion may be a stimulate.

Appearance:

Crying

Dirty clothes

Patient appears less 

irritable and is transferred to 

the PICU.  The mother has 

disappeared and you notify 

child protective services

The cerebral 

infarct leaves 

residual brain 

damage

Failure to treat 

hyperpyrexia results 

in seizures and coma

Wait “15 minutes” for BP 

to drop further

Assess ABCs and establish IV. 

Attach a monitor/defibrillator and 

interpret EKG (Sinus Tachycardia).

GI decontamination with activated 

charcoal. Send blood for toxicology.  

Treat irritability, sinus tachycardia, 

and hypertension with IV 

Diazepam, fluids, and cooling 

blanket, then wait “15 minutes”.   

Perform actions

Treat hypertensive 

urgency with IV 

Enalaprilat (Vasotec) and 

wait “15 minutes”
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NSR with PVCs

HR 150

RR 20

   BP 80/60 

O2 Sat: 98%

NSR

Healthy Resting

Transition Time: 1 min

Yes

Asystole

Immediate Transition

End End

V-Fib

BP 0

RR 10

Immediate Transition

No

Torsades de Pointes

BP 58/0

RR 20

Cyanotic

Seizures

Eyes closed

Transition Time: 10 sec 

30 second wait

Pediatric HAL
®
 One Year - Cardiac Scenario

Congenital Heart Failure

A one year old boy is transferred to your facility with a history of weakness and seizures despite 

therapeutic levels of anticonvulsants.  Normal CT Scan, spinal fluid, and electrolytes.  

The chart shows  

no Magnesium 

level ordered.  

Appearance:

Mild seizures

Eyes open (no blinking)

Seizures stop

IV Magnesium 

Sulfate
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Inspiratory Stridor

HR 180

RR 40

BP 82/20

O2 Sat 88%

Wait indefinitely for: 

Additional Epinephrine

IV

Steroids

Benadryl

Wait indefinitely for anti-

hypertensive infusion

Wait indefinitely for:

Oxygen

Epinephrine

Nebulized Albuterol

No

BP 111/76

RR 30

O2 Sat 92%

Transition Time: 30 sec

O2: 92%

Color: Pink

HR: 150

RR: 30

BP: 90/60

Transition Time: 45 sec

Yes

End

Pediatric HAL
®
 One Year - Systemic Scenario

Bee Sting

You are called to a home where a one year old boy was bitten multiple times by angry “Yellow 

Jackets” thirty minutes ago.  When you arrive you see areas of hives around the bites, his lips and 

eyes are swollen and he has audible stridor.

Appearance:

Crying and mildly cyanotic.  

Assessment: 

Anaphylaxis with 

hypoxia, tachycardia 

and hypotension

Favorable 

response



Pediatric HAL S3005 | User Guide | 161 

HR 180

RR 30

   BP 80/60

 O2 Sat: 93%

Temp: 38.1 Deg C

Eyes closed

End

Wait indefinitely for two 

boluses of Ringer’s Lactate

HR 150

Seizures

Transition Time: 30 sec

Healthy resting

Transition Time: 1 min

Wait indefinitely for switching 

IV fluid to Normal Saline

Pediatric HAL
®
 One Year - Systemic Scenario

Hypovolemic Shock
Hyponatremic Seizures

A one year old boy presents to the ED with a three day history of vomiting and watery diarrhea with 

out blood or mucous. He attends daycare and a note was sent home about two other children with 

rotovirus diarrhea.  He was given Pedialyte the first day and his vomiting and diarrhea decreased on 

the second day.  Today, however his diarrhea is constant and he has refused to drink.  His urine 

output is unclear because of the diarrhea in the diapers. During your assessment he has a thirty 

second period of tremors.

Appearance:

Sleepy, but responsive 

to parent’s voice

Assessment: Dehydration and early 

compensated nonhemorrhagic 

hypovolemic shock.  Airway and 

breating stable.    

Action: IV access with bolus 

of 20cc/kg of Ringer’s 

Lactate over “15 minutes”.  

Obtain blood for chemistry.  

After the first “15 minutes” 

vitals stay the same, so 

administer a second bolus 

and wait another “15 

minutes”

Assessment: Possible 

hyponatremia.  Blood chemistry 

returns and serum Na is 120 

mEq.  Calculate sodium deficit 

and replacement fluids

HR 150

BP 100/60

RR 30

Transition Time: 30 sec

Wait indefinitely for 

dopamine or 

dopbutamine drip.
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Troubleshooting 
Symptom Possible Cause Solution 

Communication never 
gets established or is lost 

(blinking communica-
tion indicator is con-
sistently red) 

Battery connectors in the manikin 
are reversed  

Make sure to connect red wire to red 
terminal, and black to black 

Battery is discharged Make sure battery is charged.  

Computer is too far away from 
simulator 

Get simulator closer to computer 

Trying to communicate with a 
different simulator 

Make sure to select the right simulator when 
opening the software. 

In a multiple simulator environment, make 
sure to enter the right Serial Number 

Starting more than one simulator 
with its own tablet  

Select different channels for each of the 
simulators, and then turn them on one at a 
time, meaning:  Wait until a link has been 
established between the tablet and 
the simulator (the yellow window goes 
away). 
 
Only after that, start running the GaumardUI 
software in the second tablet, and so on for 
the rest of the simulators. To do so, go to 

menu Setup  Options  Environment  
Select “Auto change to channel: #” (# = 
number from 1 – 11). 

All others Close the GaumardUI software and unplug 
the RF module for at least 5 seconds, then 
plug it back in.  

Disconnect one terminal from the battery and 
reconnect after 5 seconds. 
 
Restart the software and wait for initialization 

Simulator doesn’t run for 
the time specified on the 
manual  

Battery not charged properly Make sure that LED indicator on battery 
charger goes through the sequence 
described in its label, usually red or orange 
after plugging it, and then green when 
charge is completed. 

 
If LED does not go through label’s 
indications, then: 
 

 Check plug connection making 
sure it is all the way in. 

 Make sure you are using the 
appropriate charger, labeled with 
its simulator name 

Simulator doesn’t 
respond to any com-
mand even that blinking 
communication indicator 
is consistently green 

The computer is properly 
communicating with a simulator, 
but not necessarily the one you 
intend to control 

If you have more than one manikin in your 
facility, make sure that your computer is 
properly set-up to control the manikin that 
you wish to control.  Go to Options... on the 
Setup pull-down menu and check the 
Environment preferences 
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Symptom Possible Cause Solution 

Commands are taking 
longer than usual to take 
effect or simulator is not 
reporting every action 
(blinking communica-
tion indicator is consis-
tently yellow) 

Distance between computer and 
manikin is reaching its limit 
or 
there are too many obstructions 
between (walls, etc) 

Get simulator closer to computer or move 
away from obstructions 

There’s too much RF interference 
either from another Gaumard 
tetherless simulator in the vicinity 
or an RF radiator. 

Try changing the RF channel by going to the 

menu for Setup  Options  Environment 

 Select “Auto change to channel: #” (# = 
number from 1 – 11). 

GaumardUI has set the 
power mode to STAND-
BY automatically 

The battery on the manikin is 
depleted 

Plug charger for all others including 

"RF module not found" 
message is displayed 
when GaumardUI is 
started 

RF module not connected  Connect the RF module to any USB port. 

RF module not identified by the 
computer 

Close the software and try disconnecting the 
RF module for at least five seconds, then 
plug it back in and restart the software 

Chest compressions are 
not properly detected or 
not detected at all 

Is the communication indicator 
panel consistently yellow? 

See solution above in section making 
reference to “blinking communication 
indicator is consistently yellow” 

Is the respiratory rate set to “0 / 
min”?  Chest compressions are 
only detected when the 
respiratory rate is set to 0 per 
minute (0 / min).  Otherwise they 
are ignored 

Set respiration rate to zero 

All others See “Calibration Wizard” section inside 
User’s Manual 

Artificial ventilations are 
not properly detected or 
not detected at all 

Is the communication indicator 
panel consistently yellow? 

See solution above in section making 
reference to “blinking communication 
indicator is consistently yellow” 

All others See “Calibration Wizard” section inside 
User’s Manual 

Simulator’s chest does 
not rise with artificial 
ventilation (e.g. BVM) 

Simulator not running In some simulators, the trachea is 
disconnected from the lungs when they are 
not on. 

Disable lung/s Enable the lungs from “Detail” page on the 
GaumardUI software 

Low chest rise (or no 
chest rise at all) while 
breathing  

Wrong settings or disabled lungs Make sure lungs are enabled and both 
respiration rate and inspiration percent are 
different than “0”. Try changing the 
respiration rate to a different value, and if still 
nothing happens, try turning the manikin off 
and restarting everything to make sure the 
internal air compressor gets its initial settings 

Loss of brachial pulse Brachial pulses disabled  Make sure to enable brachial pulse on 
“Details” tab page 
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Symptom Possible Cause Solution 

Pre-built scenarios don’t 
show up 

 Select “Quick Start Scenarios” when starting 
the software. 
 
Should user forget to do so, there’s no need 
to shut down the software and open it again 
in order to load the pre-built scenarios. Go to 
“File/Profile” menu and then select “Modeled 
Scenarios” 

A sound is absent or is 
not heard at desired 
volume level 

Volume not set to user’s criterion. Every sound has a volume control. Play with 
the volume control to get it to the desired 
level. 
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Wireless Network 
GIGA generates the vital signs information 
displayed on the virtual monitor PC. The 
information is transmitted through a wireless 
ad-hoc connection between the two 
computers in real time. 

The wireless settings are configured at the 
factory, so no additional configuration is 
required. Please reference the 
troubleshooting section to resolve common 
connectivity issue before attempting to 
reconfigure the network. 

Use the “Create an ad-hoc Wireless 
network” tool to configure the wireless ad-
hoc link between the two computers. Then, 
configure the connection between GIGA and 
the Gaumard Monitors software. 

GIGA NETWORK 
CONFIGURATION 

Complete the next steps using the 
“Controller - Create Ad-Hoc Wireless 
Network” tool built in to GIGA software.  

1. From the menu bar, go to Help > 
“Create ad-hoc Wireless Network” 

The “Controller - Create Ad-hoc 
Wireless Network” window is displayed 

2. Select the “Wireless Network Adapter”. 
If the wireless adapter is not listed, first 
enable the adapter using the Windows

®
 

network menu and then return to this 
window. 

 

3. Enter a wireless network name (case 
sensitive). Use the same wireless 
network name to configure the Gaumard 
Monitors PC. “GaumardNet” is the 
required name for Windows

®
 7 

computers. 

 

4. Set the “Controller IP”.  

On each control PC and virtual monitor 
PC, enter the same values for the first 
three IP fields and a set unique value for 
the last field. The suggested address is 
for the Controller IP is 10.1.1.200 

 

5. Click “Apply Wireless Network Settings” 
to save the settings. 

6. Restart the computer. 

 

GAUMARD MONITORS NETWORK 
CONFIGURATION 

After the GIGA control computer is 
configured, complete the next steps using 
the “Create an ad-hoc network tool” included 
in Gaumard Monitors software.  

1. On the virtual monitor computer, click 
the Gaumard Monitors icon to start the 
vital signs software. 

2. Click the V menu near the top left corner 
and select “Create Ad-Hoc Network”. 
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The “Virtual Monitor - Create ad-hoc 
Wireless Network” window is displayed. 

3. Select “Wireless Network Adapter”. If 
the wireless adapter is not listed, first 
enable the adapter using the Windows

®
 

network menu and then return to this 
window. 

 

4. Enter a wireless network name (case 
sensitive). Use the same name entered 
in the controller computer. 
“GaumardNet” is the required name for 
Windows

®
 7 computers.  

 

5. Set the “Monitor IP”.  

On each control PC and virtual monitor 
PC, enter the same values for the first 
three IP fields and a set unique value for 
the last field. The suggested address is 
for the Monitor IP is 10.1.1.220 

 

6. Click “Apply Wireless Network Settings” 
to save the settings. 

7. Restart the computer. 

 

CONFIGURE THE VITAL SIGNS 
BROADCAST 

After the wireless ad-hoc link is established 
between both computers, complete next 
steps to configure the transmission of the 
vital signs information.  

1. Verify that both computers are 
connected to the GaumardNet network 
using Windows

®
 wireless connection 

menu. If the computers are not 
connected, select the “GaumardNet” 
network and click “Connect” manually. 
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2. Start the GIGA control software. 

3. On the GIGA menu bar, click Monitors> 
Configuration. 

The “HAL Virtual Monitor Setup” window 
is displayed. 

4. Set the adapter to “Wireless network 
connection” and click “Connect” to begin 
transmitting the vital signs information. 
Write down the “controller IP” and “Port 
number”.  

5. Start the Gaumard Monitors software on 
the virtual monitor PC. 

6. Click the “V” menu near the top left 
corner, and then select “Comm Setup”. 

The “TCP Comm Setup” window is 
displayed. 

7. Enter the “Controller IP” and “Port 
number” displayed on the GIGA “Virtual 
Monitor Setup” window.  

Click “Connect” to accept the incoming 
connection. 
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Spare Parts List 
Contact Gaumard Scientific for a complete list of consumables and replacement parts and their 
prices. 

S3005 Part ID Name Type Description 

S3005.001 A/C Virtual Monitor A A/C Powered 17" Touch Screen monitor and 
desktop 

S3005.002 D/C Virtual Monitor A D/C Powered 12" Touch Screen Mobile Monitor with 
stylus 

S3005.010 Battery  C Rechargeable battery  

S3005.011 Battery Charger R 100-240 V AC battery charger with label 

S3005.013 Power cord R   

S3005.029R.L I/O Leg Skin Cover  C Light color skin cover for right leg tibia bone 

S3005.031  I/O Tibia bones C I/O leg tibia reservoir bones 

S3005.053L.D Upper LEFT Arm  M Dark color upper left arm assembly with  tethered 
BP with adaptor 

S3005.053R.L Upper RIGHT Arm  M Light color upper right arm assembly with tethered 
BP with adaptor 

S3005.081 Silicone Oil C Oil-based silicone lubricant 

S3005.200 Audio & Video 
Recording System 

A   

S3005.206 RF Module R Radio Frequency Module with USB connector 

S3005.223L.L Lower Left Arm 
Reveining 

M Lower left IV arm reveining, light color 

S3005.223R.L Lower Right Arm 
Reveining 

M Lower right IV arm reveining, light color 

S3005.300 Wireless Streaming 
Audio  

A Wireless streaming audio feature 

S3005.300.U Wireless Streaming 
Audio Upgrade 

U   

S3005.DEMO Adult PEDIATRIC 5YO 
Demo Unit 

   

S3005.EXW Two Year Extended 
Warranty 

A Extended warranty for years Two AND Three 

S3005.INST In-Service Training A Day of in-service training and installation 
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S3004 Part ID Name Type Description 

S3004.001 A/C Virtual Monitor A A/C Powered 17" Touch Screen monitor 
and desktop 

S3004.002 D/C Virtual Monitor A D/C Powered 12" Touch Screen Mobile 
Monitor with stylus 

S3004.010 Battery  C Rechargeable battery  

S3004.011 Battery Charger R 100-240 V AC battery charger with label 

S3004.013 Power cord R   

S3004.029R.L I/O Leg Skin Cover  C Light color skin cover for right leg tibia bone 

S3004.031  I/O Tibia bones C I/O leg tibia reservoir bones 

S3004.053L.D Upper LEFT Arm  M Dark color upper left arm assembly with  
tethered BP with adaptor 

S3004.053R.L Upper RIGHT Arm  M Light color upper right arm assembly with 
tethered BP with adaptor 

S3004.081 Silicone Oil C Oil-based silicone lubricant 

S3004.200 Audio & Video 
Recording System 

A   

S3004.206 RF Module R Radio Frequency Module with USB 
connector 

S3004.223L.L Lower Left Arm 
Reveining 

M Lower left IV arm reveining, light color 

S3004.223R.L Lower Right Arm 
Reveining 

M Lower right IV arm reveining, light color 

S3004.300 Wireless Streaming 
Audio  

A Wireless streaming audio feature 

S3004.300.U Wireless Streaming 
Audio Upgrade 

U   

S3004.EXW Two Year Extended 
Warranty 

A Extended warranty for years Two AND 
Three 

S3004.INST In-Service Training A Day of in-service training and installation 
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Warranty 
EXCLUSIVE ONE-YEAR LIMITED WARRANTY 

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or workmanship 
within one year from the date on which the product is shipped from Gaumard to the customer, Gaumard will, at 
Gaumard’s option, repair or replace the Gaumard product. 

This limited warranty covers all defects in material and workmanship in the Gaumard product, except: 

1. Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product; 

2. Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard 
product instructions, including failure to property clean the Gaumard product; and 

3. Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than Gaumard 
or a Gaumard representative. 

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the 
accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied warranties of 
merchantability, satisfactory quality, and fitness for a particular purpose. Except for the limited obligations 

specifically set forth in this one-year limited warranty, Gaumard will not be liable for any direct, indirect, special, 
incidental, or consequential damages, whether based on contract, tort, or any other legal theory regardless of 
whether Gaumard has been advised of the possibilities of such damages. Some jurisdictions do not allow disclaimers 
of implied warranties or the exclusion or limitation of consequential damages, so the above disclaimers and 
exclusions may not apply and the first purchaser may have other legal rights. 

This limited warranty applies only to the first purchaser of the product and is not transferable. Any 

subsequent purchasers or users of the product acquire the product “as is” and this limited warranty does not apply. 

This limited warranty applies only to the products manufactured and produced by Gaumard. This limited 

warranty does not apply to any products provided along with the Gaumard product that are manufactured by third-
parties. For example, third-party products such as computers (desktop, laptop, tablet, or handheld) and monitors 
(standard or touch-screen) are not covered by this limited warranty. Gaumard does not provide any warranty, express 
or implied, with respect to any third-party products. Defects in third-party products are covered exclusively by the 
warranty, if any, provided by the third-party. 

Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard. 

In the event of a perceived defect in material or workmanship of the Gaumard product, the first purchaser must: 

1. Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the Gaumard 
product to Gaumard without prior authorization. 

2. Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the original 
bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 Street, Miami, FL, 
33196-5691 USA. 

3. If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first 
purchaser will pay only the incidental expenses associated with the repair, including any shipping, handling, 
and related costs for sending the product to Gaumard and for sending the product back to the first 
purchaser. However, if the repairs are not covered by this limited warranty, then the first purchaser will be 
liable for all repair costs in addition to costs of shipping and handling. 

EXTENDED WARRANTY 

In addition to the standard one year of coverage, the following support plans are available: 

 Two-Year Extension (covers second and third years) 

Call for pricing (USA only) 
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Contact 
On the web  

www.Gaumard.com 

Technical Support  

support@gaumard.com 

Sales and Customer Service sales@gaumard.com 

Phone: 

Toll-free in the USA: (800) 882-6655 

Worldwide: 01 (305) 971-3790 

Fax: (305) 667-6085 

Before contacting Tech Support you must: 

 Have the simulator’s Serial Number (located in the left leg under the IM site) 1.

 Be next to the simulator if troubleshooting is needed 2.

Gaumard Scientific  

14700 SW 136 Street 

Miami, FL 33196-5691 USA 

Office hours: Monday-Friday, 8:30am - 4:30pm EST (GMT-5, -4 Summer Time)  

Always dispose of this product and its components in compliance with local laws and regulations. 

 

The HAL simulation system is protected by US patent; other Patents Pending.  

Gaumard®, HAL®, GIGA™ are trademarks of Gaumard Scientific Company, Inc. 

© Gaumard Scientific Company, 2013. Made in U.S.A. All rights reserved. 
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